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This document, the Epiphan web site, and the information contained therein, including but not limited to the text, videos 

and images as well as Epiphan System Inc.’s trademarks, trade names and logos are the property of Epiphan System s 

Inc. and its affiliates and licensors, and are protected from unauthorized copying and dissemination by Canadian 

copyright law, United States copyright law, trademark law, international conventions and other intellectual property laws. 

Epiphan, Epiphan Video, Epiphan System s, Epiphan System s Inc., and Epiphan logos are trademarks or registered 

trademarks of Epiphan System s Inc., in certain countries. All Epiphan product names and logos are trademarks or 

registered trademarks of Epiphan. All other company and product names and logos may be trademarks or registered 

trademarks of their respective owners in certain countries. For additional terms and conditions, refer to sections at 

the end of document. 
 

Copyright © 2018 Epiphan System s Inc. All Rights Reserved. 
 

THE SOFTWARE LICENSE AND LIMITED WARRANTY FOR THE ACCOMPANYING PRODUCT ARE SET FORTH IN THE 

INFORMATION PACKET OR PRODUCT INSTALLATION SOFTWARE PACKAGE THAT SHIPPED WITH THE PRODUCT AND 

ARE INCORPORATED HEREIN BY REFERENCE. IF YOU ARE UNABLE TO LOCATE THE SOFTWARE LICENSES OR LIMITED 

WARRANTY, CONTACT YOUR EPIPHAN REPRESENTATIVE FOR A COPY. 

PRODUCT DESCRIPTIONS AND SPECIFICATIONS REGARDING THE PRODUCTS IN THIS MANUAL ARE SUBJECT TO 

CHANGE WITHOUT NOTICE. EPIPHAN PERIODICALLY ADDS OR UPDATES THE INFORMATION AND DOCUMENTS ON 

ITS WEB SITE WITHOUT NOTICE. ALL STATEMENTS, INFORMATION AND RECOMMENDATIONS ARE BELIEVED TO BE 

ACCURATE AT TIME OF WRITING BUT ARE PRESENTED WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED. 

USERS MUST TAKE FULL RESPONSIBILITY FOR THEIR APPLICATION OF ANY PRODUCTS. 

LIMITATION OF LIABILITY 
 

UNDER NO CIRCUMSTANCES SHALL EPIPHAN BE LIABLE FOR ANY INCIDENTAL, SPECIAL, CONSEQUENTIAL, 

EXEMPLARY OR OTHER INDIRECT DAMAGES THAT RESULT FROM THE USE OF, OR THE INABILITY TO USE, THIS 

PRODUCT OR THE INFORMATION CONTAINED IN THIS DOCUMENT OR PROVIDED ON EPIPHAN’S WEB SITE, EVEN IF 

EPIPHAN HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT SHALL EPIPHAN’S TOTAL 

LIABILITY TO YOU FOR ALL DAMAGES, LOSSES, AND CAUSES OF ACTION RESULTING FROM YOUR USE OF THIS 

PRODUCT, WHETHER IN CONTRACT, TORT (INCLUDING, BUT NOT LIMITED TO, NEGLIGENCE) OR OTHERWISE, EXCEED 

THE AMOUNTS YOU PAID TO EPIPHAN DURING THE MOST RECENT THREE-MONTH PERIOD IN CONNECTION WITH 

AMOUNTS WHICH YOU PAID FOR USING THIS PRODUCT. 

INFORMATION AND DOCUMENTS, INCLUDING PRODUCT SPECIFICATIONS, PROVIDED IN THIS DOCUMENT OR THE 

EPIPHAN WEB SITE ARE PROVIDED “AS IS”. SPECIFICALLY, BUT NOT WITHOUT LIMITATION, EPIPHAN DOES NOT 

WARRANT THAT: (i) THE INFORMATION IS CORRECT, ACCURATE, RELIABLE OR COMPLETE; (ii) THE FUNCTIONS 

CONTAINED ON THE EPIPHAN WEB SITE WILL BE UNINTERRUPTED OR ERROR-FREE; (iii) DEFECTS WILL BE 

CORRECTED, OR (iv) THIS WEB SITE OR THE SERVER(S) THAT MAKES IT AVAILABLE ARE FREE OF VIRUSES OR OTHER 

HARMFUL COMPONENTS. EPIPHAN SPECIFICALLY DISCLAIMS ALL REPRESENTATIONS, WARRANTIES, AND 

CONDITIONS, EITHER EXPRESS, IMPLIED, STATUTORY, BY USAGE OF TRADE OR OTHERWISE INCLUDING BUT NOT 

LIMITED TO ANY IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT, TITLE, SATISFACTORY QUALITY 

OR FITNESS FOR A PARTICULAR PURPOSE. 



Thank you for choosing Epiphan! 
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Epiphan Video社では製品の機能や品質の向上に努めています。お客様のご要望にお応えできる製品づ

くりに日々尽力しています。 

 

製品のフィードバック 

お客様よりお寄せいただくご意見はとても大切です。メーカーでは皆さまのご要望にお応えできるように製品の

向上に努めて参りますので、もし何か改善点など、ご要望がございましたらご連絡ください。株式会社アルゴ 

info@epiphan.com   株式会社アルゴ：argo@argocorp.com 

 

仕様 

Epiphan社ならびに弊社のHPには、本製品に関する最新の製品仕様と追加情報を掲載されています。 

アルゴHP：https://www.argocorp.com/grabber/eizou/Epiphan/DVI2USB3.html 

 

保証 

すべてのEpiphan Video社製品には、出荷日から1年間の交換保障（通常の使用での故障時）が付いています。 

 

技術的なサポート 

Epiphan Video社では専門のサポートチームがおりますので、もしご利用の製品で何か不具合がありましたら、

詳細を下記までご連絡ください。弊社（株式会社アルゴ）よりご購入いただきましたお客様は、弊社までお問い

合わせください。問い合わせの内容によってはメーカーとの連絡を弊社よりさせていただきます。株式会社アル

ゴ（TEL：06-6339-3366／Mail：argo@argocorp.com） 

⚫ Em ailing support@epiphan.com 

⚫ Live chat via the link on our support site https:// www.epiphan.com/ support/ 

⚫ Phone toll free at 1-877-599-6581 or call +1-613-599-6581 

可能な限りより多くの情報をご提供くださいますようお願い申し上げます。 

⚫ 現象についての詳細情報 

⚫ 映像・音声ソースの詳細（形式、解像度、リフレッシュレートなど） 

⚫ 対象製品のシリアル番号 

⚫ ファームウェアバージョン 

⚫ LEDライトの状況 

 

Copyright © 2018 Epiphan System s Inc. All Rights Reserved. 

mailto:support@epiphan.com
https://www.epiphan.com/support


DVI2USB 3.0 Release notes 

iii 

 

 

 

DVI２USB3.0のファームウェアアップデート3.30.7.8は、安定性とパフォーマンス強化を含むメンテナンス

リリースです。最新ファームウェアバージョンでの改善をご希望の際はアップデートを行ってください。

（基本的に、Epiphan社では最新ファームウェアバージョンでのサポートとなります） 

重要事項: このファームウェアアップデート3.30.7.8は、DVI2USB3.0用のWindows32ビットドライバーバー

ジョンを含む最終アップデートです。 

 

Web broadcasting demo機能の削除 

Web broadcasting demo機能はEpiphan Capture Toolから削除され、アイコンはツールバーに表示されなく

なりました。 

 

推奨ビデオコーデック (2019年３月) 

このユーザーガイドでは、クイックスタートで推奨されているffdshowビデオコーデックをK-Lite（メガ）ビデ

オコーデックパックのx264vfwコーデックに置き換えるための更新が行われました。 

 

ユーザーガイドで更新されたFCCコンプライアンスステートメント 

(2020年４月) 

カナダのイノベーション、科学、経済開発に関するISED規則のICES-003のコンプライアンスステートメントが

このユーザーガイドに追加されました。また、FCCの注意事項が追加されました。 
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Start here 
 

 

DVI2USB 3.0. ユーザーガイドのこのセクションのトピックをご覧いただくと、DVI2USB3.0を素早くご利用いた

だけます。 

付属品、DVI2USB 3.0とは?で本製品の概要を、システム要件でPCの仕様をご確認いただき、クイックスタート

をご参照の上ビデオグラバーをインストールすると、すぐにご使用いただけます。 

 

DVI2USB 3.0とは? 

DVI2USB3.0™は、EpiphanのプロフェッショナルシリーズのDVI-Iビデオグラバーです。 VGA、HDMI、DVI-Iビ

デオソースから画像や映像をキャプチャし、USB3.0ポートへの接続を介してPCでデジタイズします。 

 

ビデオキャプチャワークステーションは、結果として得られる非圧縮の画像および映像を記録・ストリーミング

できます。 Windowsでは、オーディオキャプチャとビデオキャプチャの両方がHDMIソースでサポートされてい

ます。 Epiphan Videoキャプチャテクノロジーは、コンピュータのUSB 3.0ポートに直接接続することを可能し

ました。PCIスロットを備えた大型のワークステーションは必要ありません。 

DVI2USB 3.0は、シングルリンクのDVI、暗号化されていないHDMI、VGAソースからビデオとオーディオをキ

ャプチャします。より大きなファイルをより高速で転送するため、USB 3.0で接続し、最大5.0（Gbits / s）の速

度で非圧縮データを転送できます。これはUSB2.0の約10倍の速度です。 
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DVI2USB 3.0は用途が広く、様々なワークステーション構成で使用できます。 USB 2.0接続との下位互換性があ

りますが、USB 2.0を使用すると、フレームレートを下げて映像を転送します。 

付属のEpiphan Capture Toolを使用して、DVI2USB3.0は30フレーム/秒でフルHD 1080pをキャプチャし、最大

1920×1200の解像度をサポートします。 YUV 4：2：0クロマサブサンプリングを備えたWindows Media 

Encoderなどのサードパーティソフトウェアを使用する場合、1080p、60フレーム/秒でキャプチャされます。 

サードパーティのアプリケーションを使用してビデオをキャプチャ、保存、ストリーミングするときにフレーム

レートを最大化する方法の詳細については、EpiphanのWebサイトにあるHow to Record Video using Window 

Media Encoderを参照してください。 

DVI2USB 3.0ビデオグラバーは、WindowsのDirectShow、LinuxのVideo4Linuxと完全に互換性があります。そ

のため、ビデオのキャプチャ、保存、ストリーミングのために、さまざまなサードパーティアプリケーションで

使用できます。 

DVI2USB 3.0は、Epiphanのビデオ、オーディオ信号キャプチャ製品ラインナップの一部です。その他のビデオ

信号キャプチャ製品の詳細については、Epiphan Video WebサイトのUSB Video Grabbers ページ（アルゴＨ

Ｐ：https://www.argocorp.com/grabber/eizou/dpgrab.html）をご参照ください。 

 

付属品 

DVI2USB 3.0には以下の付属品が含まれます 

1. DVI2USB 3.0 本体 (参照：各部名称と紹介) 

2. DVI-I ケーブル ×1 

3. VGA-DVI ケーブル ×１ 

4. HDMI-DVI アダプター ×１ 

5. USB 3.0 ケーブル ×１ 

 

 

 

 

実際には、転送速度はUSB負荷やハードウェア構成などの要因に依存します。 

https://www.epiphan.com/solutions/record-video-using-windows-media-encoder-windows-8/
https://www.epiphan.com/solutions/record-video-using-windows-media-encoder-windows-8/
https://www.epiphan.com/products/compare-usb-video-grabbers/
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Table 1  ※ 付属品の仕様（色や見た目）は画像と異なることがあります。 
 

Image Name Description 

 

DVI-I ケーブル 
DVI信号ソースをキャプチャデバイスに接続し

ます。 

 

VGA-DVI ケーブル 

VGA信号ソース（またはコンバータと一緒に使

用する場合はコンポーネント）をキャプチャデ

バイスに接続します。 

 

HDMI-DVI アダプター 
HDMIソースをDVI-Iケーブルに接続し、ビ

デオグラバーに接続します。 

 

 

USB 3.0 ケーブル 

ビデオグラバーをキャプチャワークステーショ

ン、コンピュータに接続するケーブル 
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システム要件 

システム要件は、コンピュータがEpiphanビデオグラバーと連携するために必要な技術的要素です。

DVI2USB3.0を使用するためのシステム要件は次のとおりです。 

 

 

映像ソース 

VESA規格準拠のVGA、DVI、HDMI入力信号 (ただ

し、 HDCPの信号はキャプチャできません) 

 

 

 

 

ビデオキャプチャワークステーション 

次の機能を備えたコンピュータ（ラップトップ/デ

スクトップ/その他）: 

SuperSpeed操作用の互換性のあるUSB3.0ホ

ストコントローラー（推奨インテル

®USB3.0eXtensibleHost Controller） 

⚫ USB2.0コントローラー 

ビデオキャプチャワークステーションOS  

Windows 10 

RAM 最小推奨値: 4 GB 

有効なハードディスク容量 16 GB (32bit OS) または 20 GB (64bit OS) 



DVI2USB 3.0 User Guide Quick start 

5 

 

 

 

クイックスタート 

このクイックスタートをお読みいただくと、WindowsのキャプチャワークステーションでDVI2USB3.0を簡単に

起動し、ご利用いただけます。またファームウェアアップデートのインストールについても記載しています。  

ご利用前に: 

⚫ 必要なケーブル、コンポーネント、アダプター（必要な場合）をすべて用意します。付属品を参照して

ください。 

⚫ キャプチャワークステーションがシステム要件を満たしていることを確認します。 

⚫ カメラ、コンピュータ、タブレットなどの映像ソースを用意し、コンテンツがHDCPで保護されていない

ことを確認します。 Windowsシステムの場合、音声と映像が同じソースケーブルで出力されていること

を確認してください。 

⚫ ドライバをダウンロードするためのインターネットアクセス 

⚫ キャプチャワークステーションの管理者権限 

 

ビデオグラバードライバのインストール 

ビデオグラバーをビデオキャプチャワークステーションに接続する前に、こちらの手順を完了してください。 

1. (オプションとして) ビデオグラバーが現在接続されている場合は、キャプチャワークステーションから

ビデオグラバーを切断する 

2. 管理者権限を持つアカウントを使用してキャプチャワークステーションにログインする。ワークステー

ションがドメイン上にある場合は、ドメインのアカウントではなく、ワークステーションのローカル管

理者アカウントにログインしていることを確認してください。 

3. キャプチャワークステーションでWebブラウザを使用して、Epiphan ソフトウェアダウンロードサイ

ト ＞ Epiphan  キャプチャユニット/ボード ＞ キャプチャソフトウェア Epiphan Capture Toolにある

オペレーティングシステムに適切なドライバをダウンロードする。 

 

 

 

https://www.argocorp.com/grabber/eizou/Epiphan/Epiphan_software.html
https://www.argocorp.com/grabber/eizou/Epiphan/Epiphan_software.html
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4. ダウンロードが完了したら、ダウンロード先フォルダを開く 

5. (オプションとして) 不要なウィンドウをすべて閉じ、ワークステーションで実行されているプ

ログラムをシャットダウンします。厳重に制限されたセキュリティソフトウェアは、デバイスド

ライバのインストールをブロックする可能性があることに注意してください。その場合、キャプ

チャワークステーションでドライバの更新を許可する手順については、ご所属のシステム管理者

に相談してください。  

6. すべてのドライバファイルを展開し、WindowsワークステーションにドライバとEpiphanキャ

プチャツールをインストールします。 

a. .zipファイルを右クリックしてすべて展開をクリックする 

b. 展開したファイルフォルダから、setup.exeを右クリックし、管理者として実行を選択する 

c. インストールをクリックし、プロンプトに従ってドライバをインストールする。 Epiphan 

Capture Toolは、ドライバと同時にインストールされます。 

7. インストールが完了したら、キャプチャワークステーションを再起動しビデオグラバーを再接

続します。

 

Windows 10オペレーティングシステムの場合、必要に応じて、64ビットまたは32ビットのい

ずれかのドライバを選択します。必要なドライバのバージョンがわからない場合は、このマ

イクロソフトサポート技術情報の記事https://support.microsoft.com/enus/kb/827218を参

照してください。 

 

インストーラーが管理者として実行されている場合でも、Windowsドメインからセ

キュリティアクセス許可を継承しているコンピュータのインストールが失敗する場

合があります。その場合は、ご所属のITチームにインストールのサポートを依頼し

てください。 
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Windows用のビデオコーデックをインストールし、ビデオ圧縮オ

プションを設定する 

Windowsオペレーティングシステムの場合、K-Lite（Mega）ビデオコーデックパックをインストールする

ことをお勧めします。このコーデックパックは、Epiphan Capture Toolを使用して映像を録画するためのビ

デオ圧縮オプションを追加します。圧縮せずに録画すると、特に高解像度で録画する場合に大量のディスク

領域が消費されるため、お勧めしません。メーカーではテストの結果、このコーデックパックのコーデック

x264vfwが、ビデオグラバーでの使用に適しているとしています。 

K-Lite（Mega）ビデオコーデックパックをWindowsキャプチャワークステーションにインストールする手順

は、以下の通りです。 

1. 管理者権限を持つアカウントを使用してキャプチャワークステーションにログインし、Epiphan Capture 

Toolを起動する 

2. ToolsメニューからOptions...を選択し、DisplayタブのDisplay formatがRGB 24 bits per pixel（初期設

定）に設定されていることを確認する 

3. キャプチャワークステーションでWebブラウザを使用して、K-Lite（Mega version）ビデオコーデック

パックをダウンロードする。（32ビットと64ビットバージョンが含まれています） 

⚫ K-Lite (Mega) video codec pack 

注意）K-Lite Codec Pack MegaとK-Lite Codec Packは異なります。上記リンクページのServer１、

Server２、Server３のいずれかをダウンロードし、インストールしてください。同時に異なるもの

をインストールしないでください。 

  
4. ダウンロードした実行可能ファイルを見つけ、ファイルをダブルクリックし、プロンプトに従って、

WindowsバージョンのK-Lite（Mega）コーデックパックをインストールする。Normalのインストール

モードを使用し、初期設定のオプションを受け入れます。コーデックパックのインストールが完了した

ら、Finishをクリックします。 

https://codecguide.com/download_k-lite_codec_pack_mega.htm
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5. Epiphan Capture ToolのToolsメニューからOptions...を選択し、Recordingタブをクリックする 

6. Recordingタブで、Record asフィールドをVideoに設定し、Select Codecをクリックする 

7. 圧縮プログラムのドロップダウンで、x264vfw - H.264/MPEG-4 AVC compressionを選択し、OKをクリ

ックする 

 

8. 変更を保存するため適用をクリックする。すべての設定を終えたらOKをクリックします。 

 

最も一般的なインストールでは、ビデオ圧縮コーデックのデフォルト設定を使用し

ます。ビデオ圧縮パラメータを設定する必要はありません。 
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ビデオグラバーと映像ソースを接続する 

ドライバとビデオコーデックのインストールが完了すると、キャプチャを始める準備が整います。以下の

手順では、映像ソースをグラバーに接続し、次にグラバーをワークステーションに接続するように記載し

ておりますが、映像ソースとビデオグラバーは任意の順序で接続できます。 

1. 映像ソースをビデオグラバーのDVI-Iポートに接続する （必要に応じて、アダプターまたは適切なコ

ンバーターケーブルを使用してください。） 
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2. 付属のUSB3.0ケーブルをビデオグラバーの下部に接続する 

 

3. USBケーブルのもう一方の端をビデオキャプチャワークステーションの使用可能なUSBポートに接続

する（仕様通りのパフォーマンスを得るにはUSB 3.0ポートを使用してください）。 
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Epiphan Capture Toolを使って映像をキャプチャする 

必要に応じて、キャプチャツールの起動方法についてEpiphan Capture Toolをご参照ください。 

 

1. Epiphan Capture Toolを起動する。映像ソースがすぐに検出されます。（No Signalというメッセー

ジが表示された場合は、ケーブルを抜き挿しし、すべてが正しく接続されていることを確認しま

す） 

 

 

映像ソースにスプリッタケーブルを使用する場合は、高品質のHDMIまたはDVIスプリッターを

使用して、他のデバイスとビデオグラバーの間で信号を分割します。 VGA信号の場合は、パッ

シブVGAスプリッター（Yアダプターとも呼ばれます）ではなく、アクティブVGAスプリッター

を使用します。これによりクリーンなビデオ信号を維持するのに役立ちます。 

 

サードパーティのキャプチャアプリケーションを使用して、DVI2USB3.0からビデオをキャプチ

ャすることもできます。デバイスを選択するには、サードパーティのキャプチャアプリケーシ

ョンに付属のドキュメントを参照してください。 
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2. ビデオグラバーから音声をキャプチャする場合は、ツールバーのEnable Audio (音声を有効にする)ボ

タンをクリックする。音声が有効になっていることを示すためにアイコンが変化します。 （ソースに

音声がない場合、または別の音声入力方法を使用する場合は、Capture » Audio Input Deviceを選択

して音声ソースを選択します。） 

 

 
 

3. 赤い録画ボタンを使用して録画を開始する。Saveダイアログで保存するファイル名とフォルダを指定

します。 

 

 
4. キャプチャが完了したら、一時停止または停止ボタンを押す 

 

5. オペレーティングシステムのファイルブラウザを使用して、保存したキャプチャファイルを確認する 

 

 

 

What’s next? 

基本的な録画ができましたら、以下の機能もお試しください。 

 

エンベデッドオーディオのキャプチャに問題がある場合は、ビデオグラバーがUSB3.0ポートに

接続されていることを確認してください。キャプチャするデータ量が多いため、エンベデッドオ

ーディオキャプチャは、USB3.0経由で接続されている場合にのみ可能です。 

 

デバイスに古いまたは正しくないEDIDがロードされていると、HDMIオーディオ  キャプチャ

が失敗する場合があります。参照：EDIDのアップデート 
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⚫ Configure your deviceデバイス設定 

⚫ DirectShow video 調整 

⚫ Epiphan Capture Tool 

 

それぞれのトピックスの詳細については目次をご確認ください。 

LEDライトの詳細 

LEDライトの色と動作は、USB3.0とUSB2.0のどちらで接続されているかによって異なります。最高のパフ

ォーマンスを発揮するため、USB3.0ポートと付属のUSB3.0ケーブルを使用してください。 USB 2.0経由で

接続すると、フレームキャプチャレートが低下しますのでご注意ください。 

コントローラーがUSB3.0またはUSB2.0のどちらであるかわからない場合は、DVI2USB 3.0をキャプチャコ

ンピュータに接続し、LEDライトを確認します。（この場合、ビデオグラバーに映像ソースが接続されてい

ないことを前提としています） 

 

  

青点滅：USB3.0 緑点滅：USB 2.0 

 

 

 

LED color USB 3.0 connection USB 2.0 connection 

 

 

赤点灯 

ビデオグラバーの電源はオンになっていますが、機能していま

せん。ドライバがインストールされていないか、ロードに失敗

しました。 Epiphan Capture Toolとドライバをインストール

した場合は、USBケーブルの抜き差しをお試しください。 

赤点滅 

ビデオグラバーのセキュリティ検証に失敗しました。製品のシ

リアル番号とシステムの詳細をEpiphanへ報告する必要があり

ます。弊社までお知らせください。 

黄点灯 画像/ビデオキャプチャ、データ転送が進行中です。 
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青点滅 

ファームウェアが正常にロー

ドされ、デバイスは待機状態

です。 

- 

緑点滅 

ビデオモードの検出が進行中で

す。 

ファームウェアが正常にロー

ドされ、デバイスは待機状態

です。 

緑点灯 - 
ビデオモードの検出が進行中で

す。 
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トラブルシュート 

DVI2USB 3.0で問題が発生している場合は、以下をご参照いただき問題修正をお試しください。 

 

Capture device not found 

 Epiphan Capture Toolがビデオグラバーを検出しない場合、キャプチャアプリケーションにCapture device not 

foundというメッセージが表示されます。 

 

以下お試しください: 

⚫ ビデオグラバーがキャプチャワークステーションのUSBポートに接続されていることを確認しま

す。接続するとデバイスのLEDが点灯します。 

⚫ USBケーブルを抜き挿しし、ビデオグラバーの再接続を行います。これにより、オペレーティングシス

テムは、ビデオグラバーのドライバがまだロードされていない場合それらをロードできます。 

⚫ インジケータLEDの色を確認し、LEDライトの詳細に記載されているリストと比較します。 

⚫ Windowsでは、Windowsのデバイスマネージャーを確認して、デバイスのリストにビデオグラバー

が表示されていることを確認します。 

⚫ 上記を試しても問題が解決しない場合は、すべてのアプリケーションを閉じて、ビデオキャプチャ

 

スプリッターを使用する場合は、常に高品質のスプリッターを使用してください。 VGAスプリ

ッターの場合、パッシブまたはYアダプタースプリッターではなくアクティブVGAスプリッター

を使用してください。 
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ワークステーションを再起動します。 

No signal detected 

 Epiphan Capture Toolがビデオグラバーを検出したものの、接続された映像ソースが表示されない場合、キャ

プチャアプリケーションにNo signal detectedというメッセージが表示されます。 

 

以下お試しください: 

⚫ アプリケーションで使用されているビデオグラバーが正しいことを確認します。アプリケーション画

面の右上に表示されるシリアル番号（上記の例では300292）を、デバイスの背面にあるシリアル番号

のステッカーと比較します。一致しない場合は、Capture » Select device...（Windows）で別のビデ

オグラバーを選択します。 

⚫ 映像ソースの電源が入っていること、ビデオグラバーに接続されているビデオケーブルにデータを出力

していることを確認します（これは、映像ソースのハードウェアまたはソフトウェアの設定である可能

性があります）。 

⚫ 映像ソースをビデオグラバーから切断して再接続します。 

⚫ インジケータLEDの色を確認し、LEDライトの詳細に記載されているリストと比較します。 

 

設定変更を適用する「apply」ボタンが 表示されない 

Windowsでは、Epiphan Capture Toolで設定変更を適用するためのボタンが表示されない場合、アプリケーシ

ョンは管理者権限なしで開かれています。アプリケーションを閉じてから、管理者権限で再度起動してくださ

い。 

 



DVI2USB 3.0 User Guide Troubleshoot 

17 

 

 

Windowsワークステーションの電源を入れても、接続されている

ビデオグラバーが検出されない 

ワークステーションで高速スタートアップを無効にしてみてください。 [コントロールパネル]> [電源オプショ

ン]> [電源ボタンの動作を選択する]で高速スタートアップを無効にし、[現在利用可能でない設定を変更します]

で[高速スタートアップを有効にする]の選択を解除できます。 

Windowsキャプチャワークステーションの問題が解決しない場合 
電源設定を変更してみてください。 [コントロールパネル]> [電源オプション]> [プラン設定の変更]から、電源

オプションが[高パフォーマンス]に設定されていることを確認します。ノートPCの場合は、ACアダプターが接

続されていることを確認してください。 

また、[プラン設定の変更]で、次の高度な電源設定を変更します。 

⚫ USB 設定: USBのセレクティブサスペンド設定を無効に変更します。 

⚫ PCI Express: リンク状態の電源管理をオフにします。 

 

デバイスマネージャーを開き、ユニバーサルシリアルバスコントローラーの下で、ここにリストされている

すべてのUSB 3.0ハブに、[プロパティ]> [電源管理]で[電源の節約のために、コンピュータでこのデバイス

の電源をオフにできるようにする]設定が無効になっていることを確認します。 
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デバイス設定 
 

 

Epiphan Capture Toolを使用すると、画像調整を微調整し、VGAモード（アナログソース用）を選択して、ビデ

オグラバーがDirectShow互換アプリケーションでどのように機能するかを制御できます。 

メニューオプションは、ビデオグラバーに接続しているソースの種類によって異なります。一部のメニュー項目

はVGAソースにのみ適用できるため、VGAソースが接続されている場合にのみ表示されます。 

設定画面にアクセスするには、次のいずれかを実行します。 

1. Epiphan Capture ToolのメニューCapture » Configure Device... を開く 

2. Windows コントロールパネルを開く 

a. Epiphan Frame Grabbersをクリックする。 Epiphan Frame Grabber の設定画面が開きます。 

b. 設定を行いたいデバイスを選択する 

c. Edit Configurationをクリックする。開いた設定画面で編集する 

DirectShow video 調整 

Epiphan Capture Tool のCapture » Configure Device » DirectShowページでは、デバイスがDirectShow互換

アプリケーションへデータを受け渡す方法を設定できます。解像度から画像を反転するかどうかまで、さま

ざまなオプションを利用できます。各オプションの説明については、以下の表をご参照ください。 

コントロールパネルのEpiphan Frame Grabbersを使用して、設定するビデオグラバーを選択し、Edit 

DeviceまたはDefault Configurationをクリックして、この画面にアクセスすることもできます。 

ここで行った調整はデバイスドライバに保存され、再度変更するまで使用されます。適用後、設定した値を使

用するためにEpiphan Capture Toolを開いたままにする必要はありません。サードパーティのDirectShow互換

アプリケーションに設定が反映されていない可能性があることに注意してください。変更を確認できない場合

は、サードパーティアプリケーションの詳細設定を確認してください。 
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Item Description 

 

 

 

Fix resolution 

このチェックボックスを使用して、ビデオグラバーがDirectShow互換ア

プリケーションに受け渡す解像度を指定します。チェックボックスをオン

にすると、ドロップダウンボックスに解像度を選択するための解像度のリ

ストが表示されます。 

ソース信号よりも小さいまたは大きい解像度を選択した場合、Epiphanドラ

イバが画像を拡大縮小します（Scale image to match stream resolutionの

チェックを外さない限り、選択した解像度に一致するように画像がトリミ

ングされます） 

 

Default image 

ビデオグラバーからキャプチャされた信号がないときに表示する画像

を選択します。非圧縮のBMPイメージは、ビデオキャプチャワークス

テーションに保存する必要があります。 
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Scale image to match stream 

resolution 

固定解像度（fixed resolution）を使用していて、画像を拡大縮小（scale 

the image）しないことを選択した場合、DirectShow互換ユーティリティ

でキャプチャすると、キャプチャされた画像は指定された解像度にトリミ

ングされて表示されます。通常、トリミングはビデオの左上隅で行われま

すが、最初にテストして、表示結果をご確認ください。 

通常、DirectShowで固定解像度を使用することを選択する場合は、

Epiphanドライバで画像を拡大縮小する必要があります。スライダーを使

用して、必要なスケーリングのタイプを決定します。スケーリングパフォ

ーマンスは、キャプチャコンピュータの品質とCPUサイクルの間のトレー

ドオフです。低品質（スライダーの左側）は高速でCPUサイクルが少なく

て済みますが、高品質（スライダーの右側）は低速でCPU時間が長くなり

ます。さまざまな値を試して、ご利用ケースに適した値を見つけてくださ

い。 

 

Flip image vertically 

DirectShowを送信するときにキャプチャした画像を垂直方向に反転す

るには、このチェックボックスを使用します。 

 

 

 

 

Limit frame rate to 

DirectShowに送信するデータのフレームレートを制限（または修正）し

ます。 

たとえば、WebExなどのDirectShow互換アプリケーションを使用して

いて、比較的動きのないもの（PowerPointプレゼンテーションなど）

を共有している場合は、フレームレートを5 fpsに制限できます。この

フレームレートは見ている分には十分で、視聴者側のデータ帯域の圧

迫を抑えることができます。 
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映像の見え方の調整 
Adjustments ページでは、データをわずかに変化させたり、キャプチャのカラーモードを設定したりできます。 

VGA信号が接続されている場合は、VGA固有のチューニングパラメータを設定するためのオプションも利用でき

ます。 

この画面にアクセスするには、Capture » Configure Device » Adjustmentsを選択するか、コントロールパネル

のEpiphan Frame Grabbersから、設定するビデオグラバーを選択し、Edit DeviceまたはDefault Configuration

をクリックします。 

メインのadjustments画面は、接続されているソースに応じて次のようになります。（左側：HDMIまたは

DVIソース、右側：VGAソースの場合に表示される画面） 

 

Item Description 

 

 

 

Horizontal shift 

キャプチャされた画像の位置をオフセットするように水平位置を微調

整します。たとえば、キャプチャした画像が少し右に（水平に）移動

すると、horizontal shiftの設定を少し調整するだけで修正できます。 

Horizontal shiftに入力した値を大きくすると、画像が右に移動し、小

さくすると、画像が左に移動します。 
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Vertical shift 

キャプチャされた画像の位置をオフセットするように垂直位置を微調

整します。たとえば、わずかに下に（垂直に）移動されたキャプチャ

画像は、vertical shift設定をわずかに調整することで修正できます。 

Vertical Shiftに入力された値を増やすと画像が上に移動し、減らすと

画像が下に移動します。 

 

Set offset/ gain 

(brightness/ contrast) 

VGA ソースのみ 

オフセットとゲインの設定は、それぞれ画像の明るさとコントラストを制

御します。 

オフセットコントロールを大きくすると、画像が暗くなります。ゲインコ

ントロールを大きくすると、画像のコントラストが高くなります。 

 

Sam pling phase 

VGA ソースのみ 

この設定は、画像の垂直同期プロパティを調整します。画像の横軸に繰り

返しの歪みやぼやけがある場合にお試しください。より鮮明な画像が表示

されるまで、設定を少しずつ調整します。 

PLL adjustment 

VGA ソースのみ 

 

こちらの設定は画像を水平方向に縮めるか、伸ばすかを調整します。 

 

 

 

Prefer wide VGA mode 

VGA ソースのみ 

このチェックボックスを使用すると、ワイドアスペクト比のVGAモード

をビデオキャプチャアプリケーション画面に表示できます。 Epiphan 

USBデバイスドライバは、映像ソースがワイドビデオモード信号を送信

しているかどうかを判断できない場合があります。映像ソースがワイド

ビデオモードを使用して、Epiphan USBデバイスドライバがワイドビデ

オモードを選択していることを確認する場合は、このオプションを選択

できます。 

 

YCrCb capture 

通常、DVI2USB 3.0は入力タイプを自動検出しますが、入力タイプが検

出されない問題が発生した場合は、このチェックボックスを選択して、

YCrCbエンコーディングでアナログコンポーネントビデオをキャプチャ

できます。 

 

Swap interlaced fields 

一部のソースからキャプチャする場合、ビデオグラバーはインターレ

ースラインを配置する順序を正しく決定できません。このチェックボ

ックスを使用してライン順を反転できます。 
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VGA modesの設定 

VGA Modes ページではアナログビデオキャプチャに使用するVGAモードを設定できます。 

この画面にアクセスするには、Capture » Configure Device » VGA Modesを選択するか、コントロールパネル

のEpiphan Frame Grabbersから、設定するビデオグラバーを選択し、Edit ConfigurationまたはDefault 

Configurationをクリックします。 

ビデオグラバーは、初期設定で一般的なVGAモードをサポートします。ただし、カスタムVGAソース（カスタ

ム解像度またはタイミング）からキャプチャする場合は、ここに追加できます。ソースのキャプチャパラメー

タを調整するときにビデオグラバーが使用しないようにするVGAモードのチェックを外すこともできます。 

 

Custom VGA modeを追加する: 

1. Epiphan Capture Toolを起動する 

2. Capture » Configure Device を選択する。設定画面が表示されます。 

3. VGA Modes タブを選択する 

4. カスタムモードを追加するため、+ボタンをクリックする。設定画面が表示されます。 
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5. Horizontal pixels と Vertical lines でカスタムフレームサイズを指定する 

6. ソースのRefresh rateを指定し、それがインターレースか、ブランキングを減らす必要があるかを

チェックする 

ソースが特殊なタイミングを使用している場合は、Standard VESA timingsのチェックを外す。一連

の技術的なタイミングの詳細が表示され、それぞれにカスタムタイミング値を入力します。 （ソー

スのタイミング値がわからない場合は、標準のVESAタイミングを使用し、Configure Deviceの

Adjustmentsタブを使用して画像を微調整します。） 
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Advanced 調整 
Advancedタブペでは、デバイスの自動調整、検出メカニズムを設定できます。 

この画面にアクセスするには、Capture » Configure Device » Advancedを選択するか、コントロールパネルの

Epiphan Frame Grabbersから、設定するビデオグラバーを選択し、Edit Configuration または Default 

Configurationをクリックします。 

詳細調整の内容は次のとおりです。 

 

 

Item Description 

 

 

Auto-adjustment interval 

ビデオグラバーが自動調整の間に使用する間隔を秒単位で指定します。通

常、この値を変更する必要はありませんが、キャプチャ中にソースを頻繁

に変更する場合は、間隔を短くすることをお勧めします。 

 

On-board compression 

このオプションは、USB2.0ポートに接続されている場合にのみ表示され

ます。 USB 2.0ポートに接続したときに着信信号のオンボード圧縮を有効

にするには、このオプションを選択します。  

Sync level adjustment 

HSync and VSync 

 

水平および垂直同期レベルを調整します。 



DVI2USB 3.0 User Guide Epiphan Capture Tool 

26 

 

 

 

 

 
 

 

Epiphan Capture Tool 
 

Epiphan Capture ToolはWindowsで利用できる無料のソフトウェアアプリケーションです。ソースからの画

像をキャプチャ、録画することに使用でき、サードパーティの DirectShow対応プリケーションで使用するよ

うにビデオグラバーを設定することもできます。 

Epiphan Capture ToolはEpiphanが提供するドライバを使用するすべてのEpiphanのビデオキャプチャデバイ

スでご利用いただけます。（ DVI2USB 3.0、SDI2USB 3.0、DVI2PCIe Duo ) そのため、ソフトウェアの一部

の機能はDVI2USB3.0に適用されていない内容も含まれます。このガイドでは、関連する機能の概要と、各機

能の使用方法について説明します。 

 

 

DVI2USB3.0は入力タイプを自動検出します。ただし、入力タイプが検出されない場合は、

AdjustmentsタブからYCrCbエンコーディングを使用してアナログコンポーネントビデオをキャ

プチャするように(YCrCb capture)手動で選択できます。ビデオグラバーがインターレースライ

ンを配置する順序を正しく判断できない場合は、Adjustmentsタブからインターレースフィール

ドを交換すること(Swap interlaced fields)もできます。 
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Epiphan Capture Tool 

アプリケーションを起動するには、Windows スタートメニュー から スタート » Epiphan Capture Toolを選

択するか、インストールされているデスクトップアイコンをダブルクリックします。 

アプリケーションが起動し、PCに接続されているDVI2USB3.0ビデオグラバーを探します。 

 

ビデオグラバーが接続されて動作している場合、キャプチャアプリケーションはそれを検出し、キャプチャさ

れている画像がアプリケーション画面に表示されます。 

 

アプリケーションが起動すると、次のメッセージが表示される場合があります。 

⚫ Capture device not found ：アプリケーションがビデオグラバーとの接続を試みる場合 

⚫ Detecting Video Mode ：アプリケーションがデバイスと接続し、デバイスのビデオモードを決定

する場合 

⚫ Tuning Capture Parameters ：アプリケーションがキャプチャ設定と画像調整を同期および調整す

る場合  

⚫ No Signal Detected ：アプリケーションにアクティブな映像ソースに接続されていないビデオグラバー

を接続している場合（入力信号が接続されていないか、映像ソース機器からの出力がない場合） 

映像ソースが接続されているときにビデオグラバーデバイスが画像をキャプチャしない場合は、トラブルシ

ュートをご参照ください。 
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Epiphan Capture Tool には以下のメニュー項目があります。 

 

 
 

他のメニューについては、以下をご参照ください: 

File メニュー、Edit メニュー (Windows)、 View メニュー、Capture メニュー、Tools メニュー、Help メ

ニュー、ツールバー、ステータスバー 

現在選択されている

ビデオグラバー 現在のキャプチャ

情報 

キャプチャソース 

メニュー 

ツールバー 

ツールバー 
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メニュー 

Epiphan Capture Toolのメニューについて紹介します。 

 

 

 

File メニュー 

Fileメニューの内訳です。 

 

 

 

Menu item Short cut Description 

 

Save 

 

Ctrl+S 

現在の画像のスナップショットをビデオキャプチャワークステーショ

ン上のファイルに保存します。スナップショットを保存するにはをご

参照ください。 

 

Save As... 

 

Ctrl+Shift+S 

新しい名前または形式を使用して、現在の画像のスナップショッ

トをファイルに保存します。参照 スナップショットを保存するに

は 
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Print Setup... 

 

Ctrl+Shift+P 

プリンター設定ダイアログを開き、プリンターを選択したり、プ

リンターオプションを設定したりできます。 

Print Ctrl+P 現在の画像のスナップショットを印刷します。参照 スナップショット

を印刷するには 

Exit 
 

アプリケーションを終了し、Epiphan Capture Toolを介して実行され

たすべてのキャプチャと録画を終了します。 

 

Edit メニュー (Windows) 

Edit メニューの内訳です。 

 

 

 

Menu item Short cut Description 

 

Copy 

 

Ctrl+C 

クリップボードに現在の画像のスナップショットをコピーしま

す。 参照スナップショットをコピーするには 

 

 

View メニュー 

Viewメニューの内訳です。 
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Menu item Short cut Description 

 

Toolbar 

 
ツールバーアイコンのサイズを変更するか、ツールバーを表示/非表示にしま

す。 （ツールバーが非表示になっている場合は、サイズを選択して復元

（ restore）します。） 

 

 

Status Bar 

 
アプリケーションウィンドウの下部にあるステータスバーを表示または非表

示にします。 

 

 

 

Full Screen 

 

Ctrl+F 

フルスクリーンモードを有効にします。 ESCキーを押して戻ります。 

 

 

 

 

Image Only 

 

 

 

 

(ESC to exit) 

Epiphan Capture Tool画面を、ツールバー、ステータスバー、メニューバ

ーが表示されないモードにします（スクロールバーは引き続き表示される

場合があります）。こちらのモードは、Epiphan Capture Toolをカスタム

システムUIに統合するのに役立ちます。既存のショートカットキーは引き

続き使用できます。 

ESCキーを押して、通常の操作表示モードに戻ります。 

 

Capture メニュー 

Captureメニューの内訳です。 

 

Captureメニューでは、キャプチャ/録画の開始、停止、一時停止を行えます。また、ビデオキャプチャワーク

ステーションに複数のEpiphanビデオグラバーが接続されている場合に、アプリケーションのこのインスタンス

が動作するDVI2USB3.0デバイスを選択することもできます。 
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Menu item Short cut Description 
 

Start Recording 

(Stop Recording) 

 

Ctrl+R 

キャプチャしたデータを映像、一連の画像として録画を開始/停止します。

参照映像保存と 一連の画像として保存 

Pause Capture 

(Resume 

Capture) 

 

Ctrl+U 

 

キャプチャと保存を一時停止/一時停止解除します（最後のフレームは画

面に表示されたままになります）。参照ビデオキャプチャの一時停止 
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Select Device... 

 

 

 

 

 

 

 

 

Ctrl+N 

ビデオキャプチャワークステーションに複数のEpiphanビデオグラバーが接

続されている場合に使用します。 

 

 

 

 

 

 

Epiphan Capture Toolのこのインスタンスで使用するデバイスを選択し、

OKをクリックします。 

Connect 

Network 

Device... 

  

 

 

 

 

DVI2USB3.0は対応していません。販売終了のVGA2Ethernetデバイス

で利用する機能です。 

Disconnect 

Network 

Device 

Recent 

Network 

Devices 

Enable Audio 

Capture 

(Disable 

Audio 

Capture) 

 

 

Ctrl+A 

 

有効にすると、デバイスまたは外部オーディオソースからキャプチャされ

た音声が録画に含まれます。参照 音声設定 

Audio 

Input Device 

 
サブメニューを開き、オーディオキャプチャに使用する入力デバイスを選

択できます。参照 音声設定 
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Play 

Captured Audi 

o 

 
有効にすると、キャプチャされた音声がビデオキャプチャワークステー

ションで再生されます。（ワークステーションのスピーカーや接続され

たヘッドホンなどを介して）録画している音声を確認したり、キャプチ

ャした音声をローカルの視聴者と共有したりするためのモニタリング用

として使用します。 

Play Captured Audio 設定を動作させるには、Enable Audio Captureを

有効にする必要があります。 

Configure 

Device... 

 

Ctrl+Shift+C 

ビデオグラバーの特定のキャプチャ調整を設定する画面を開きます。参照

デバイス設定 

 

Tools メニュー 

Epiphan Capture ToolのToolsメニューでは、カスタムEDIDをアップロードし、アプリケーションオプションを

設定できます。 

 

 
 

Tools メニューの内訳です。 

 

Menu item Short cut Description 

 

Upload EDID to Device... 

 
カスタムEDIDをビデオグラバーにアップロードしま

す。参照EDIDのアップデート 

 

Read EDID from Device... 

 
デバイスのEDIDを読み出します。参照EDIDのアップ

デート 
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Measure VGA Mode... 

 
Epiphanテクニカルサポートから要求された場合、この

コマンドを使用して、問題の診断に役立つ情報を表示で

きます。この情報を電子メールにコピーしてご提供くだ

さい。 

 

Upgrade EDIDs for all Devices 

 
Epiphanでは、ビデオグラバー用にEDIDを随時リリースし

ています。このツールを使用して、更新を確認し、適用し

ます。 

 

 

Options 

 
ビデオキャプチャ、録画などに関連するオプション設

定ができます。参照 アプリケーションオプション 

 

アプリケーションオプション 

Epiphan Capture Toolには、Tools » Optionsメニューからアクセスできる、いくつかの設定オプションがあり

ます。 

 

次のカテゴリのオプションを使用できます：Recording、On-Screen Text、KVM、Sharing、Display、

Capture、Audio、Startup 

 

 
 

Options の内訳です。 

 

Menu item Description 

 

 

 

Display 

Epiphan Capture Toolでキャプチャされた画像を表示する方法と、ステー

タスバーに表示する情報を制御できます。表示形式の詳細については表示

オプションの設定を、オプションのステータスバーインジケーターの説明

と例についてはステータスバーをご参照ください。  
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Capture 

クロッピングを設定できます（ビデオフレームの特定の部分のみをキャ

プチャするため）。参照 キャプチャイメージをクロップする 

このタブから、video mode detection(ビデオモードの検出)試行の間隔

を変更することもできます。数値を小さくすると、グラバーが別のビデ

オモードをチェックする頻度が高くなりますが、グラバーの動作が激し

くなり、フレームレートが低下する可能性もあります。 

キャプチャのlimit the frame(フレームレートを制限)することもできま

す。これは、ストリーミング（または録画）中に、帯域幅（ディスク容

量）が少なく、データ量を抑えたい場合に必要になることがあります。 

 

 

 
Audio 

録画の音声形式、使用するオーディオソース、キャプチャワークステー

ションの音声出力デバイスでキャプチャされた音声をEpiphan Capture 

Toolで再生するかどうかを設定できます（キャプチャされた音声をモニ

タリングするためにローカルスピーカー、ヘッドホンで再生）。オーデ

ィオキャプチャの設定については、音声設定をご参照ください。 

 

 

Startup 

Epiphan Capture Toolをフルスクリーンモードで起動するかどうかを選

択できます。 

このタブの他のオプションは、販売終了製品（VGA2Ethernetなどのネッ

トワーク接続ビデオグラバー）に使用されます。 

 

Recording 

映像、画像として保存するようにキャプチャアプリケーションの保存

機能を設定できます。参照映像保存、一連の画像として保存 

 

On-Screen Text 

Epiphan Capture Toolを使用すると、キャプチャしたフレームにテキスト

を追加できます。このタブでは、そのテキスト内容を設定できます。参照

文字の追加 

KVM こちらの機能はKVM2USB用です。DVI2USB3.0ではご利用いただけませ

ん。 

 

https://www.epiphan.com/products/kvm2usb/
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Help メニュー 

Epiphan Capture ToolのHelpメニューを使用すると、ソフトウェアの更新の確認、製品の登録、現在のソフ

トウェアのインストールに関する情報の確認ができます。 

 

 

Help » Check for Updatesメニューを使用して、Epiphan Capture Toolとドライバの更新を確認できます。ソフ

トウェアの更新バージョンがある場合もありますが、新しい機能が追加されたり、使用しているビデオグラバ

ーのモデルが更新されたりすることはありません。最新版ではない場合ドライバとソフトウェアのアップグレ

ードで記載している方法でソフトウェアをアップデートすることができます。 
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ツールバー 

Epiphan Capture Toolツールバーには、キャプチャの開始、停止、一時停止、スナップショットの保存

など、頻繁に使用される機能のクイックアクセスボタンがあります。 

ツールバー: 

 

 

View » Toolbar » (size) Iconsから、ツールバーのアイコンのサイズを変更できます。 

 

View » Toolbar » Hide Toolbarでツールバーを非表示にできます。非表示のときにツールバーを再度表

示するには、ツールバーアイコンのサイズのいずれかを選択します。 

ツールバーのアイテム: 

 

Icon 

(Windows) 

 

Description 

 

 

現在キャプチャされているフレームのスナップショットを保存します。最初にキャプ

チャを一時停止することをお勧めします。参照スナップショットのコピー、保存、印

刷 

 

 

 

現在キャプチャされているフレームを印刷します。最初にキャプチャを一時停止する

ことをお勧めします。参照 スナップショットのコピー、保存、印刷 

 

 

 

現在キャプチャされているフレームをクリップボードにコピーします。最初にキャプ

チャを一時停止することをお勧めします。参照スナップショットのコピー、保存、印

刷 

 

 

 

キャプチャされたフレームの録画を開始（または停止）します。（画像、ビデオ形

式）参照 Record a video 映像保存と 一連の画像として保存 
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キャプチャと録画を一時停止します。 （録画ファイルは閉じます。） 

 

 

 

音声キャプチャの有効/無効にする。参照音声設定 

 

スナップショットのコピー、保存、印刷 

Epiphan Capture Toolを使用して、ストリームからスナップショットのコピー、保存、印刷ができます。 

 

スナップショットを保存するには 

次のいずれかの方法で、キャプチャしているストリームを.bmp、.jpg、.png形式で保存します。オプション

として、画像を保存する前にビデオキャプチャの一時停止ができます。 

⚫ File » Saveを選択する 

⚫ Ctrl+Sを押す 

⚫ ツールバーの保存アイコンを使う 

 

 

スナップショットを初めて保存すると、[名前を付けて保存]ダイアログが開き、ファイルの保存場所とファ

File » Save As...またはCtrl+Shift+Sを使用しない限り、後続の画像はこのファイルを自動的に上書きしま

す。 

 

スナップショットを印刷するには 

次のいずれかの方法で、ストリームからスナップショットを直接印刷できます。オプションとして画像を保

存する前にビデオキャプチャの一時停止 ができます。 

⚫ File » Printを選択する 

⚫ Ctrl+Pを押す 
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⚫ ツールバーの印刷アイコンを使う 

 

 

メニューオプションのFile » Print Setup...またはキーボードショートカットのCtrl+Shift+Pで、プリンター

の選択、設定ができます。 

オプションとして、印刷用に色を反転させることができます（黒は白、黄色は青、赤はシアンなどで表示さ

れます）。印刷用に色を反転するには： 

1. Tools » Optionsを選択する。 オプションダイアログが開きます。 

2. Display タブを選択する 

3. Invert colors for printing のチェックボックスにチェックを入れる 
 

 
 

4. OKをクリックする 

 

スナップショットをコピーするには 

次のいずれかの方法で、ストリームのスナップショットをクリップボードに簡単にコピーできます。オプシ
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ョンとして、画像を保存する前にビデオキャプチャの一時停止ができます。 

⚫ Edit » Copyを選択する 

⚫ Ctrl+C を押す 

⚫ ツールバーのコピーアイコンを使う 

 

ワークステーションで別のアプリケーションを開き、クリップボードの貼り付け方法（Edit » PasteやCtrl+Vな

ど）を使用して、コピーした画像を貼り付けます。 

映像保存 

Epiphan Capture Toolは、DVI2USB3.0からキャプチャされた画像を映像として保存できます。 

 

音声をキャプチャすることを選択でき（参照音声設定）、映像の代わりに個々の画像ファイルを保存す

ることも選択できます。参照 一連の画像として保存Y 

キャプチャした映像ソースを録画するには 

 

Step 1: コーデック設定 

エンコーディングコーデックを選択してください。コーデックは、DVI2USB 3.0から非圧縮のビデオフレーム

を取得し、それらを組み合わせてデジタルビデオファイルに圧縮して、プレーヤーで表示したり、他者と共有

したり、YouTubeなどの動画共有サイトにアップロードしたりできるソフトウェアです。 

初期設定では、オペレーティングシステムにはいくつかのデフォルトコーデックがインストールされてお

り、Epiphan Capture Toolには追加のコーデックは付属していません。 x264などのサードパーティコーデッ

クをインストールするなど、ユースケースに最適なコーデックを選択ください。このユーザーガイドではコ

ーデック選択は範囲外となりますので、インターネット上でコーデックに関する多くのリソースをご覧いた

だけるかと思います。 

コーデックを設定するには: 

1. ビデオグラバーに映像ソースを接続する 
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2. ビデオグラバーをキャプチャワークステーションのUSBポートに接続する。（最高のパフォーマンスを

得るには、またはエンベデッドオーディオをキャプチャする場合は、USB 3.0を使用します）。 

3. Epiphan Capture Toolを起動する。参照Epiphan Capture Tool 

4. Tools » Options メニューを選択する。ダイアログが開きます。 

a. Recordingタブを選択する 
 

 
 

b. Record as ドロップダウンのVideoを選択する 

c. Select Codec... ボタンを押す。ビデオの圧縮ダイアログが開きます。インストールされている

コーデックから選択し、OKをクリックする。 

d. 必要に応じて、AVI file size limit （AVIファイルのサイズ制限）を変更する。この制限に達す

ると、録画は自動的に停止します。 

e. このページから、ファイル名や録画期間などの録画設定のオプションも設定できます。 
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f. 適用をクリックして、 Recording設定を保存する 

 

Step 2: 録画 

Epiphan Capture Toolで適切に設定されていれば、映像を録画するだけです。 

画像/フレームはビデオグラバーによってキャプチャされると、映像ファイルに保存されます。ステータス

バーには、ファイル名と保存先、経過時間、保存されたフレーム（または画像）の数が表示されます。 

録画するには: 

1. Epiphan Capture Toolは、映像ソースをキャプチャして表示しているはずです（No Signalが表示され

た場合は、ケーブルを取り外してから再接続して、すべてが正しく接続されているか確認します）。 

 

2. オプションとして、音声キャプチャを設定し有効にする。参照音声設定 

 

3. Capture » Start Recordingを選択するか、録画アイコン、またはキーボードショートカットCtrl-Rを
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使って録画を開始する。 
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4. ファイル名とフォルダを指定してファイルを保存する。（録画ファイル名を事前設定するために録画

設定のオプションをご参照ください） 

5. 完了したら、一時停止/停止ボタンを使用して、録画を一時停止/停止する。 （キーボードショートカ

ットのCtrl-Uを使用して一時停止する、メニューのCapture » PauseまたはCapture » Stop Recording

を使用して録画を制御することもできます。） 

 

6. オペレーティングシステムのファイルブラウザ（Windowsエクスプローラなど）を使用して、保存さ

れたファイルを探す。ステータスバーが表示されている場合、最後に保存されたファイルのファイル

名とパスは、Epiphan Capture Toolの下部にあるステータスバーに表示されます。 

 

映像ファイルがAVIファイルサイズの制限に達すると、記録構成設定に基づいて次のいずれかが発生しま

す。 

⚫ 録画の停止 

⚫ 新しいファイルが作成され、録画が継続する 

⚫ ファイルが上書きされ、録画が継続する 

 

録画オプションを設定するには、録画設定のオプションをご参照ください。 

 

エンベデッドオーディオのキャプチャに問題がある場合は、ビデオグラバーがUSB3.0ポートに

接続されているか確認してください。キャプチャする必要のあるデータの量が多いため、埋め込

み音声キャプチャは、USB3.0経由で接続されている場合にのみサポートされます。 

 

デバイスに古い、または正しくないEDIDがロードされていると、HDMI音声キャプチャが失敗す

る場合があります。EDIDのアップデートをご参照ください。 
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キャプチャイメージをクロップする 
多くの場合、DVI2USB3.0によってキャプチャされた画面すべてを表示しますが、時には、一部の情報（機

密情報や個人情報など）を削除したり、シーンの黒いバーや不要な領域を切り抜いたりする必要がありま

す。このような場合に、Epiphan Capture Toolには画像を保存する前にキャプチャされたソースをクロップ

する機能があります。 

たとえば、クロップ機能を使用すると、下の左側の画像を右側の画像のように、キャプチャ画像の表示を変

更できます。ステータスバーには、クロップされた座標が表示されます。 

 

 

キャプチャクロッピングを設定するには、まず映像保存します。 

クロッピングパラメータを指定するために: 

1. Tools » Options ダイアログからCaptureタブを選択する 

2. Enable hardware croppingチェックボックスにチェックを入れる 
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3. Width (幅)フィールドとHeight (高さ)欄で、キャプチャしたいクロップ領域のサイズをピクセル

単位で指定する 

4. Left と Top欄で、キャプチャを開始する左上隅をピクセル単位で指定する。これらの値を変更する

と、クロップされた領域で画像の表示部分が変化するのを確認できます。 

5. Apply をクリックして変更を確認し、微調整を続けるか、OKをクリックして変更を保存する



DVI2USB 3.0 User Guide Practical EDID example 

48 

 

 

 

EDIDのアップデート 

EDID（拡張ディスプレイ識別データ）は、映像ディスプレイデバイス（通常はモニター）によって提供さ

れるデータであり、その機能を映像ソース（通常はPCや別のデバイスのグラフィックス、ビデオ出力カー

ド）に記述します。映像ソースはEDIDを使用してモニターの機能を決定し、モニターがサポートできる解

像度、色深度、およびその他の設定を決定します。 

 

 DVI2USB 3.0の場合、映像ソースのモニターとして機能します。 DVI2USB3.0には対応するすべてのビデ

オモードを含む包括的なEDIDを工場出荷時にロードされています。映像ソース（ノートPCやビデオカメラ

など）を接続すると、このソースはDVI2USB 3.0をモニターとして認識し、そのEDIDを使用して送信する

映像信号をネゴシエートします。 

通常、工場出荷時にロードされているEDIDで、対応している映像ソースに対しうまく機能するはずですが、ご

使用の映像ソースが表示プロパティのカスタム設定を行っている場合は、PCやカメラ、他の映像ソースに必要

な解像度や色深度などを指定するため、ビデオグラバーにカスタムEDIDをアップロードする必要があります。 

 

特定のEDIDをロードする必要があることに加え、時にメーカーの最新工場出荷時のEDIDをキャプチャデバ

イスにアップロードしたい場合も考えられます。 

 

 

新しいEDIDをアップロードする 

ほとんどの場合、工場出荷時にインストールされたEDIDで十分ですが、映像ソースが使用したくない解像

度を使用している場合があります。その場合、ビデオグラバーに特定の属性を持たせるためEDIDを選択で

きます。 

 

EDIDはDVIソースにとって重要ですが、VGAソースではほとんど無視されます。 

 

例えば、 1040x768のみで動作するようにDVI2USB3.0にカスタムEDIDをアップロードできます。 

映像ソースがビデオグラバーからのEDIDを受け取ると、映像ソースはEDIDで設定された1024x768

で映像出力するようにリセットされます。 
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1. Epiphan support webページへアクセスし、新しいEDIDファイルをダウンロードする 

2. DVI2USB 3.0のサポートページを選択する。Select a productのプルダウンからDVI2USB3.0を選択します。 

3. EDIDセクションまでスクロールする 

4. リストからEDIDをクリックする。ダウンロードが開始し、EDIDファイルはダウンロードフォルダに保存

されます。 
 

 

5. キャプチャコンピュータにビデオグラバーを接続する 

6. 映像ソースをビデオグラバーから切断する 

7. Epiphan Capture Toolを起動する 

8. Tools » Upload EDID to device... メニューを選択する。ファイル選択ダイアログが開きます。 

 

9. 開いたダイアログからダウンロードしたEDIDファイルを探し、選択する 

 

工場出荷時のEDIDへ戻すには、ダウンロードリストにある"default configuration" EDID

を選択します。 

 

EDIDの変更は他のEDIDに置き換えるまで永続的です。 

https://www.epiphan.com/support
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10. ソースが切断されているかの再確認ダイアログが開きます。ビデオグラバーにソースが何も接続され

ていないことを確認し、OKをクリックする。 

11. しばらくすると、EDIDIのアップロードが完了します。 
 

 

 

実用的EDIDの例 

ここではキャプチャの問題をカスタムEDIDで解決する方法例を紹介します。 

 

 固定解像度640×480の映像出力デバイスとして接続されたフラットパネルモニターがあるとします。そ のフ

ラットパネルモニターをDVI2USＢ3.0に交換すると、映像ソースからの出力解像度が720×400に 変わりまし

た。 なぜ映像ソースから出力される解像度が変わったかというと、映像ソースが720×400の解像度を優先さ

せたためです。もともとフラットパネルモニターが720×400に対応していなかったため、映像ソースは

640×480で出力することになったのです。しかしDVI2USB3.0は720×400に対応しているため、自動的に優

先解像度に変わったのです。 

しかし、640×480の画面解像度が必要で、映像ソースをその解像度で動作させることができない場合に、カス

タムEDIDが有効となります。 Epiphanは、DVI2USB3.0用のカスタムEDIDを作成しています。たとえば、

720×400のサポートを除外するカスタムEDIDは、この状況を解決します。カスタムEDIDをビデオグラバーに

アップロードすると、映像ソースは720×400のサポートを検出しなくなり、640×480での動作に戻ります。  
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表示オプションの設定 

Epiphan Capture Toolsを使用すると、キャプチャしたフレームをどのように表示するか、いくつか設定で

きます。たとえば、ソフトウェアウィンドウを大きくしたり小さくしたりするときに画像を拡大縮小するか

どうか、または画面上で画像を回転させるかどうかを選択できます。 

 

表示オプション 

これらのオプションにアクセスするには、Epiphan Capture ToolのメニューからTools » Optionsを選択し、

Displayタブを選択します。 

 

 

利用可能な表示設定項目を以下で紹介します。ステータスバーに関しては別途記載しています。参照 

ステータスバー 
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Menu item Description 

 

 

 

 

Display format 

キャプチャに使用するカラースペースを変更できます。カラースペー

スはキャプチャした映像の見え方と、キャプチャできる最大フレーム

レートに影響します。カラースペースの変更はアプリケーション画面

上の表示とEpiphan Capture Toolで保存される内容に影響します。 

Epiphan Capture ToolはいくつかのRGB、グレースケールカラーフォ

ーマットに対応していますが、YUV4：2：0カラースペースに対応した

サードパーティアプリケーションを使用した場合、DVI2USB3.0はその

カラースペースでキャプチャすることもできます。 

 

 

 

1080pを60 fpsでキャプチャするには、YUV4：2：0に対応した

サードパーティアプリケーションを利用する必要があります。 

 

 

 

Image scaling 

キャプチャアプリケーション画面のサイズにキャプチャした画像を自動

的にダウンスケールするかどうかを選択します。Offにすると画像がキャ

プチャアプリケーション画面よりも大きい場合、スクロールバーが表示

されます。 

この設定は表示にのみ適用され、画像・映像保存のフレームサイズには

影響しません。 

 

 

 

Image rotation 

必要であれば、Epiphan Capture toolでキャプチャしたソースを回転で

きます。もしカメラやソースを左右に90度、180度回転させる必要があ

る場合に有効です。ドロップダウンリストから回転角度を選択し、き

ちんと表示されていることが確認できれば適用、OKをクリックして表

示を確認します。 

この設定は表示と保存された画像/映像の両方に影響します。 
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Resize window on resoultion 

change 

ソースの解像度が変更されたときにアプリケーションウィンドウのサ

イズを変更する場合は、このチェックボックスをオンにします。  

 

Invert colors for printing 

印刷用に色を反転させることを選択できます。黒は白、黄色は青、赤はシ

アンなどで表示されます。 

 

 

 

 

Flip image vertically 

このチェックボックスを選択すると、画像が垂直方向に反転します。

その効果は、キャプチャされたフレームの上端に沿ってミラーが配置

されているかのようです。 

画像を水平方向に反転するには、このオプションを選択し、180度の画

像回転を追加します。 

この設定は、表示と保存された画像/映像の両方に影響します。 
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追加機能 

ここでは、その他に役立つ機能を紹介します。 

 

ステータスバー 

Epiphan Capture Toolには、DVI2USB3.0または現在選択されているビデオグラバーに関する情報を表示する

ステータスバーがあります。設定と現在の使用状況に応じてステータスバーに追加される表示については、以

下をご参照ください。 

 

接続されているビデオグラバーがない 

ソフトウェアが接続されているビデオグラバーを検出しない場合、ステータスバーはキャプチャデバイスが

見つからないことを示します。 

 

選択されているグラバーへの入力信号がない 

現在選択されているビデオグラバーへの信号がない場合、ステータスバーはno signalのメッセージでこれを

示します。 

 

準備はできているが録画はしていない 

上記以外の場合、ステータスバーには様々な情報が表示されます。録画中ではない場合、ステータスバーで録

画開始の準備ができていることを示し、バーの右側にソース信号のVGAモードを示します。 
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録画 

初期設定では、映像を録画すると次のようになります（RECORDINGタグ、ファイルの保存場所、経過

時間、フレーム数がステータスに追加されます）。 

録画完了 

録画が完了するとステータスバーが更新され、最終的なファイルの場所と録画時間が表示されます。これ

は、アプリケーションが閉じられるか、録画が再開されるまで、ステータスバーに表示されます。 

 

画像保存 

ソースを一連の画像として保存すると、ステータスバーにRECORDINGタグと現在のファイル名が表示され

ます。 

 

画像保存完了 

画像の保存が完了すると、ステータスバーに保存された画像フレーム数が表示されます。 

 

 

オプション情報 

Tools » Options » Displayメニューで設定された項目に応じて、その他の情報をステータスバーに表示できま

す。ほぼ別々に表示されますが、これらのオプションの項目をいくつでも同時にステータスバーで表示するこ

とができます。キャプチャウィンドウがすべてのデータを表示するのに十分な幅であることを確認する必要が

ある場合があります。 

⚫ 現在のキャプチャフレームレート 
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⚫ 左上隅（例では0,0）、右下隅、クロップした結果のフレームサイズ 

 

 
⚫ 音声エンコーディング情報 

 

⚫ アプリケーションの開始以降にビデオグラバーがキャプチャしたフレームまたは画像の数 

 

 

ビデオキャプチャの一時停止 

ツールバーの一時停止ボタンを使用するか、キャプチャメニューから一時停止にアクセスするか、キーボード

ショートカットのCtrl-Uを使用してキャプチャを一時停止できます。キャプチャを一時停止すると、次のことが

起こります。 

⚫ 最後にキャプチャされたフレームはEpiphan Capture Toolで開いたままになります（新しいフレーム

は取得されません）。この画像は、保存、コピー、印刷できます。参照スナップショットのコピー、

保存、プリント 

⚫ 録画していた場合: 

⚫ 現在の録画は閉じられます 

⚫ (Tools » Options ダイアログから)キャプチャを自動的に再開する(Automatically restart 

capture)がオフになっている場合、ビデオキャプチャは停止され、ファイルが出来上が

ります 

⚫ キャプチャを自動的に再開するがオンになっている場合は、もう一度一時停止を押すか、Capture 

» Resume Captureを選択すると、設定に応じて、一時停止が解除され、既存のファイルが上書き

されるか、新しいファイルが開始されます。録画設定のオプションをご参照ください 

⚫ 画像保存していた場合: 

⚫ それ以上の画像は保存されません 

⚫ もう一度一時停止を押すとすぐに画像キャプチャが再開されます 
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キャプチャの一時停止は、ライブストリーミングも行っている場合に特に便利です。これにより、機密情報を

キャプチャせずに、別のものを準備したり、パスワードを入力したりできます。 

 

 

一連の画像として保存 

Epiphan capture toolとDVI2USB3.0を使用して保存するには、個々の画像をキャプチャする方法と映像をキャ

プチャする方法の2つがあります。映像をキャプチャする方法については映像保存をご参照ください。 

 

映像ソースを一連の画像としてキャプチャするには: 

Step 1: キャプチャモード、ファイル形式、キャプチャ頻度を設定する 

初期設定ではEpiphan Capture Toolは映像形式でキャプチャするため、画像保存を開始する前にモードを変更

することが重要です。 

画像キャプチャモードとファイル形式の設定: 

1. 映像ソースをビデオグラバーに接続する 

2. ビデオグラバーをキャプチャワークステーションのUSB3.0ポートに接続する（高いパフォー

マンスを得るためにUSB3.0を使用してください） 

3. Epiphan Capture Toolを起動する 

4. Tools » Options メニュー項目を選択する。ダイアログボックスが開きます。 

5. Recordingタブを選択する 

 

ソースを一連の画像として保存する場合、音声をキャプチャすることはできません。 
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6. Record as ドロップダウンでImagesが選択されていることを確認する 

7. Formatドロップダウンから BMP、PNG、JPEG (JPG)のいずれかを選択する 

8. Save options で: 

 

 

a. ファイルの保存先フォルダを指定する。フォルダを指定しない場合、画像はEpiphan Capture 

Toolと同じフォルダに保存されます。 

b. 必要に応じてファイルごとにカスタムPrefixを指定する 

c. Suffixドロップダウンで、サフィックスに10進数（d）または16進数（X）のどちらの文字を使用

するか、ファイル名に付く数字のゼロの数を決定します。（たとえば、％04dは、4桁の10進数

のサフィックスを意味し、先頭に3つのゼロが付きます（cap_0001.bmp）） 

d. ファイル名に使用したい最初の数値をStartで設定する 
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e. Exampleで設定したファイル名の例を確認する 

f. 新しい画像で古い画像を上書きする場合は、Overwrite existing filesチェックボックスをオンにす

る 

g. 画像がまだ保存されているかどうかに関係なく保存を続行する場合は、Ignore write failuresチ

ェックボックスにチェックを入れる。（このボックスをオンにすると、ディスクスペースが不

足した場合、またはファイルの書き込みを妨げるアクセス許可の問題が発生した場合に警告が

表示されません） 

9. 画像保存の間隔を設定する。すべてのフレームを保存すると、1秒あたり最大30枚の画像が保存されるた

め、ハードドライブの容量がすぐにいっぱいになる可能性があります。 

 

10. 画像として全フレームを保存する場合はSave all framesにチェックを入れる 

11. Skipを選択し、Xフレームごとに画像を保存する値を設定する。（たとえば、Skipを10に設定すると、10

フレームごとに画像が保存されます） 

12. Waitを選択し、画像を保存する時間間隔を設定する。数秒または数分ごとにフレームを保存します。

（ミリ秒、秒、分、時間から選択します） 

13. 特定数の画像のみを保存するか、アプリケーションに停止を要求するまで画像の保存を続行するかを決

定する。 

 

 
 

14. 録画ボタン/コントロールを使用して画像の保存を停止するには、Automatically turn recording off をオ

フのままにする。それ以外の場合は、チェックボックスにチェックを入れ、フレームまたは秒で制限を

指定します。 

15. Recording 設定を保存するために適用、OKをクリックする 
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Step 2: 録画（保存開始） 

Epiphan Capture Toolで設定ができれば、一連の画像として保存ができるようになります。 

 

ビデオグラバーにキャプチャされた画像/フレームは個々の画像ファイルとして保存されます。キャプ

チャの間、ステータスバーには最後に保存された画像のファイル名と保存先が表示されます。保存され

た画像の総数は録画が終了したときに表示されます。 

画像を保存するには: 

1. Epiphan Capture Toolは、すでに映像ソースをキャプチャしてプレビューしているはずです。No Signal

というメッセージが表示された場合は、ケーブルを取り外してから再接続して、すべてが正しく取り付

けられていることを確認します。 
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2. Capture » Start Recordingを選択するか、録画アイコン、またはキーボードショートカットCtrl-Rを

使って録画を開始する。Saveダイアログが開きます。 

 

3. キャプチャが完了したら、一時停止または停止ボタンを使用して、保存を一時停止または停止します。

キーボードショートカットの Ctrl-U を使用して一時停止するか、メニュー項目の Capture » Pause また

は Capture » Stop Recording を使用して保存を制御することもできます。 

 

4. オペレーティングシステムのファイルブラウザ（Windowsエクスプローラなど）を使用して、保存され

ている画像ファイルを見つける  

 

 

音声設定 

DVI2USB 3.0は、暗号化されていないHDMIソースから直接音声をキャプチャできます。 Epiphan Capture Tool

は、キャプチャワークステーションに接続されている他の音声デバイス（たとえば、USBやオーディオ入力ジ

ャックを介して接続されている組み込みのラップトップマイク、外部マイク）から音声をキャプチャすること

もできます。初期設定では、Epiphan Capture Toolは音声をキャプチャしませんが、設定は簡単です。 

Step 1: 音声ソースを選択する 

はじめに、キャプチャする音声ソースを選択します。これは、Tools » Optionsメニューから、または

Captureメニューから直接行うことができます。 

音声を選択するには: 

1. オペレーティングシステムを使用して外部音声ソースを設定する（通常、組み込みマイクの設
定は必要ありません）。 

2. または、HDMI ソースをビデオグラバーに接続する 

3. ビデオグラバーをキャプチャワークステーションのUSB3.0ポートに接続する。（エンベデッドオー
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ディオの代わりに外部音声ソースを使用する場合は、USB 2.0を使用できます）。 

4. Epiphan Capture Toolを起動する 

5. Tools » Optionsメニューを選択する。Optionsダイアログが開きます。 

a. Audioタブを選択する 

 

 

a. エンベデッドHDMIオーディオをキャプチャする場合は、Frame Grabberを選択する 

b. 外部音声ソースを使用している場合は、Specific Windows audio input deviceをクリックして、リ

ストから音声デバイスを選択する 

c. 必要に応じて、Audio formatドロップダウンを使用して、保存（またはストリーミング）する音声

ビットレート、ステレオ/モノラル、ビット深度を指定する。 （この値が入力している音声ビット

レートと異なる場合、DVI2USB 3.0は音声を指定されたビットレートにリサンプリングします） 

d. 必要に応じて、Play captured audioチェックボックスをオンにして、キャプチャワークステーシ

ョンの音声出力デバイス（キャプチャワークステーションに接続されたスピーカーやヘッドホン

など）で音声を再生する 

e. 適用、OKをクリックする 

 

キャプチャする必要のあるデータの量が多いため、エンベデッドオーディオキャプチャ

は、USB3.0経由で接続されている場合にのみサポートされます。 
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6. または、Capture » Audio Input Deviceを選択し、リストから音声ソースを指定する 
 

 
 

Step 2: 音声キャプチャを有効にする 

ツールバーを見ると、音声キャプチャが有効になっているかどうかが分かります。スピーカーアイコンがその

まま(音波が出ていない状態)であれば音声キャプチャは無効です。下図をご参照ください。 

 

音声有効 音声無効 

 

 

 

 

 

 

 

音声キャプチャを有効にするには: 

1. Epiphan Capture Toolを起動する 

2. ツールバーのCapture Audioボタン（スピーカーアイコン）をクリックする。音声キャプチャが有効

になっている場合、アイコンは音波でアニメーション化されます。 

音声キャプチャを無効にするには: 

1. Capture Audioボタンをクリックする。アイコンの動きがとまります。 

 

Step 3: キャプチャする 

ツールバーの録画ボタンを使用して、音声/映像ストリームをキャプチャする 
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録画設定のオプション 

映像保存で記載しているように、キャプチャしたフレームを映像として保存する場合、いくつかのオプション

設定があります。 

自動ファイル名を設定する（自動再開） 

録画と一時停止の組み合わせを使用し、Epiphan Capture Toolで前のファイルを上書きするか、最初に録画を

開始するときに指定するベースファイル名に追加されるサフィックスを作成するように設定することで、録画

するたびにファイル名を入力する必要がなくなります。 

ビデオグラバーをキャプチャワークステーションに接続し、ソースをビデオグラバーに接続します。

Epiphan capture toolを起動し、必要に応じて映像保存の手順に従い録画設定を行います。 

録画する度に同じファイルに上書きするには: 

1. Tools » Options » RecordingタブからAutomatically restart recordingチェックボックスにチェックを入れ

る 

 

 

2. Overwrite the same file (old content will be lost) のボタンをクリックする 

3. 適用をクリックする 

4. 録画を開始し、ファイルの場所と名前を入力する 

5. 録画の合間にツールバーのpauseボタン（キーボードショートカットCtrl + UまたはCapture » Pause）

を使用し、もう一度一時停止をクリックして再開し、前のファイル名を自動的に上書きする 

 

 

 

デバイスに古いまたは正しくないEDIDがロードされていると、HDMIオーディオキャプチャ 

が失敗する場合があります。参照 EDIDのアップデート 
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一連の映像ファイル（それぞれに異なるサフィックスが付いている）を保存するには: 

1. Tools » Options » Recordingタブで、Automatically restart recordingチェックボックスをオンにする 

 

2. Create a new file every time recording is restartedのボタンをクリックする 

3. Suffixドロップダウンを使用して、サフィックスに10進数（d）または16進数（X）のどちらの文字を使

用するか、およびファイル名の頭につくゼロの数を決定します（たとえば、％04dは4桁の10進数のサフ

ィックスを意味します。最初のいくつかのファイルには、3つのゼロ（cap_0001.bmp）が付きます。） 

4. 必要に応じて、ファイル名に使用したい最初の数値をstarting withで選択する 

5. 必要に応じて、同じ名前のファイルが既にある場合に自動的に上書きする場合は、Overwrite existing 

filesチェックボックスをオンにする 

6. 適用をクリックする 

7. 録画を開始し、映像ファイルの場所とルート名を指定する 

8. 録画中、ツールバーのpauseボタン（キーボードショートカットCtrl + UまたはCapture » Pause）

を使用し、もう一度一時停止をクリックして再開すると、シーケンス内の名前で新しい映像ファイ

ルを自動的に作成します。 

録画周期の設定 

必要に応じて、指定した時間が経過した後、または指定した数のフレームが保存された後に録画を停止する

ようにEpiphan Capture Toolで設定できます。たとえば、超音波装置からキャプチャするときは常に1分間の

映像が必要であることがわかっている場合などに利用できます。 

ビデオグラバーをキャプチャワークステーションに接続し、ソースをビデオグラバーに接続することから始め

ます。必要に応じて、Epiphan Capture Toolを起動し、映像保存の手順に従って録画設定を行います。 

録画するたびに同じファイルを上書きする: 

1. Tools » Options » RecordingタブからAutomatically turn recording offにチェックを入れる 
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checkbox. 

 

2. 適切な設定を選択して、フレーム数が保存された後（frames have been saved）、または指定された時

間が経過した後（elapsed）に停止するように指定する 

3. 制限を入力する。フレーム数または時間（ミリ秒、秒、分、時間） 

4. 適用をクリックする 

5. 録画を開始する。設定した停止制限が満たされると、録画は自動的に停止します。 

文字の追加 

Epiphan Capture Toolを使って、キャプチャした映像または画像に、タイムスタンプやその他固定文字をオー

バーレイで追加できます。 

 

 

タイムスタンプを追加する 

事前に作成された形式の1つから選択し、フォント、サイズ、位置、色を選択することでキャプチャした映

像にタイムスタンプを追加できます。 

ビデオグラバーをキャプチャワークステーションに接続し、ソースをビデオグラバーに接続することから始

めます。Epiphan Capture Toolを起動し、映像保存の手順に従って録画設定を行います。 

タイムスタンプのオーバーレイを設定する: 

1. Tools » OptionsダイアログからOn-Screen Textタブを選択する 

2. Timestamp チェックボックスにチェックを入れる 
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3. Formatドロップダウンからタイムスタンプの形式を選択する 

4. 必要に応じて、color（色）とoutline（アウトラインの色）を変更する。初期設定では色：白、アウトラ

インの色：グレー 

5. Position内のグリッド位置をクリックして、タイムスタンプを表示する位置を指定する 

6. Fontの横にある(...)をクリックして、フォントの種類とサイズを変更する。フォント設定ダイアログが開

きます 

7. 設定が完了したら、Applyをクリックして設定を適用する。OKをクリックするとダイアログが閉じます。 

注：タイムスタンプと固定文字のオーバーレイ両方を含められます。 

 

固定文字を追加する 

フォント、サイズ、位置、色を選択し、キャプチャした映像に固定文字を追加できます。 

ビデオグラバーをキャプチャワークステーションに接続し、ソースをビデオグラバーに接続することから始

めます。必要に応じて、Epiphan Capture Toolを起動し、映像保存の手順に従って録画設定を行います。 

固定文字オーバーレイを設定する: 

1. Tools » OptionsダイアログからOn-Screen Textタブを選択する 
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2. Static text チェックボックスにチェックを入れる 
 

 
 

3. Text field欄に文字を入力する 

4. 必要に応じて、color（色）とoutline（アウトラインの色）を変更する。初期設定では色：白、アウトラ

インの色：グレー 

5. Position内のグリッド位置をクリックして、文字を表示する位置を指定する 

6. Fontの横にある(...)をクリックして、フォントの種類とサイズを変更する。フォント設定ダイアログが開

きます。日本語表記の場合は、Sampleのドロップダウンから日本語を選択する。 

 

7. 設定が完了したら、適用をクリックして設定を適用する。OKをクリックするとダイアログが閉じま

す。 
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キャプチャした映像や画像に、テキストオーバーレイとタイムスタンプマークの両方を付けることができま

す。  

 

コマンドラインオプション 

コマンドラインオプションを使用して、Epiphan Capture Toolの起動方法を制御できます。必要な数のコマ

ンドラインオプションを任意の順序で追加します。各コマンドラインオプションは2つのダッシュで始ま

り、スペースで他のオプションと区切られます。 

次のコマンドラインオプションがサポートされています。 

 

Option Description 

 

--borderless 

画像のみのモードでキャプチャアプリケーションを起動します。 Esc

キーを押して、画像のみのモードを終了します。 

 

--sn <serial number> 

使用するビデオグラバーを指定します（複数のビデオキャプチャワー

クステーションが接続されている場合）。 < serial number >は、目

的のビデオグラバーのシリアル番号です。 

--hs <value> 水平シフト値を設定します。* 

--vs <value> 垂直シフト値を設定します。* 

--phase <value> サンプリング位相値を設定します。* 範囲は0～31 

--pll PLL調整を設定します。* 

--offset <value> オフセット（明るさ）を設定します。* 範囲は0～63 

--gain <value> ゲイン（コントラスト）を設定します。* 範囲は0～63 

 

--topmost 

キャプチャアプリケーションウィンドウを画面の一番上のウィンドウと

して保持します。 

--fullscreen Epiphan Capture Toolを全画面モードで起動します。 

 

Tip: カスタムフォントジェネレーターを使用して、会社のロゴまたはその他のグラフィックのモノト

ーンバージョンを含むフォントを生成し、画像に「文字」としてオーバーレイすることができます。

この方法を使用すると、グラフィカルな透かしがあるように見えます。 
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"* "  -デバイス設定をご参照ください 

例 

1つ以上のコマンドラインオプションを含むデスクトップショートカットを作成できます。この例では、

Epiphan Capture Toolの実行可能なファイル名はv2ugui2.exeであり、C：\ Program Files \ Epiphan \ Frame 

Grabber Softwareにインストールされます。 

1. Windowsエクスプローラを開き、次のパスに移動する：C：\ Program Files \ Epiphan \ Frame 

Grabber Software 

2. ファイルv2ugui2.exeを右クリックして、Create Shortcutを選択する。 Windowsは、Windowsの設

定に応じて、「Shortcuttov2ugui2.exe.lnk」という名前のショートカットファイルを作成します。 

Windowsでファイル拡張子が表示されない場合、“.lnk”が表示されない場合があります。 

3. 必要に応じて、このファイルの名前を変更し、別の場所にコピーする。ファイル拡張子は変更しない

でください。 

4. ショートカットファイルを右クリックして、プロパティを選択する. 

5. リンク先を編集し、終了引用符の後にコマンドラインオプションを追加する 
 

 
 

 

6. 適用を選択して、変更をショートカットに保存する 

7. ショートカットをダブルクリックして、指定したコマンドラインオプションでビデオキャプチャアプリ

ケーションを起動する 

 

たとえば、-topmostコマンドラインオプションを追加するには、ターゲット行を次のように変更します: 

"C:\ Program Files\ Epiphan\ Frame Grabber Software\ v2ugui2.exe" –topmost 

 

または、--topmost、--borderlessを追加するには、水平シフトを-67に設定し、垂直シフトを10に設

定します: 

"C:\ Program Files\ Epiphan\ Frame Grabber Software\ v2ugui2.exe" –topmost --borderless --hs 

-67 -- vs 10 
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付録 
 

 

⚫ ドライバとソフトウェアのアップグレード 

⚫ 制限と既知の問題 

⚫ Software license 
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ドライバとソフトウェアのアップグレード 

ドライバと最新バージョンのEpiphan Capture Toolは、ひとつのパッケージにまとめられており、Epiphan 

VideoサポートWebサイト（または弊社HP：ダウンロードサイト）からダウンロードできます。 メーカー

サイトでDVI2USB 3.0を登録すると、ドライバの更新が利用可能になったときに通知を受け取るように選択

できます。 

通常、古いバージョンをアンインストールせずに、新しいEpiphan Capture Toolとドライバをダウンロー

ドしてインストールできます。クイックスタートのドライバーインストール手順に従って、デバイスドラ

イバを更新し、最新のEpiphan Capture Toolをインストールするだけです。 

 

制限と既知の問題 

こちらでは、現在リリースの機能またはユーザビリティに影響を与える既知の問題や制限が記載されており、

それらの回避策を記述しています。 

⚫ ビデオグラバーは、再起動後にシステムによって認識されない場合があります。 

回避策: ビデオグラバーをコンピュータのUSBポートから物理的に切断し、再接続します。この回避策が

特定のユースケースで問題を引き起こす場合は、新しいDVI2USB3.0の購入を検討してください。ハード

ウェアの更新により、シリアル番号358800以降のデバイスでこの問題が恒久的に解決されました。 

⚫ Adobe RGB 32カラースペース（argb32）でHDMIソースをキャプチャすると、画像が破損する可能性が

あります。 

回避策: このカラースペースで画像が破損している場合は、別のカラースペースに切り替えてください。 

⚫ ビデオワークステーションで同時に複数のアプリケーションで映像信号を開くと、信号のパフォーマン

スに影響します。ライブストリーミングおよび録画中に最高のパフォーマンスを得るには、映像信号に

アクセスする不要なアプリケーションをすべて閉じることをお勧めします。たとえば、ライブストリー

ミングや録画にEpiphan Capture Toolを使用していない場合は、ビデオグラバーの構成が完了したら

Epiphan Capture Toolを閉じます。 

 

DVI2USB3.0を使用する全てのキャプチャワークステーションのドライバとEpiphanソフトウェ

アを必ず更新してください。デバイスは、デバイスを接続するたび、キャプチャコンピュータか

ら毎回ファームウェアをリロードします。 

https://www.argocorp.com/grabber/eizou/Epiphan/Epiphan_software.html#cap
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⚫ DVI2USB 3.0は、AMD Ryzen5（1600）AMD USB3.0 コントオーラーを搭載したUbuntu18.04および

16.04システムでは音声を有効にした場合キャプチャされません。 

回避策：Epiphan Capture Toolで、CaptureのEnable Audio Captureを無効にするか、USB3.0コントロ

ーラーをAMDRyzen5（2600）に更新します。 

⚫ DVI2USB 3.0は、AMD Ryzen5（1600）AMD USB3.0コントローラーを搭載したWindows10（64ビッ

ト）1709システムでは、音声が有効になっている場合はキャプチャせず、Epiphan Capture Toolを使用

して音声が無効になっている場合は非常に遅いフレームレートでキャプチャします。 

回避先: USB3.0コントローラーをAMDRyzen5（2600）に更新します。 

⚫ Epiphan Capture Toolは、VGA入力信号が1400x1050 @60fpであっても、ウィンドウタイトルで

1680x1050のラベルを付けます。入力信号は影響を受けず、タイトルのテキストを無視するか、

1400x1050 @ 60fpsのカスタムビデオモードを追加できます。 
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Software license 
ATTENTION: THE SOFTWARE AND DOCUMENTATION PROVIDED UNDER THIS AGREEMENT ARE BEING LICEN SED 

TO YOU BY EPIPHAN SYSTEM S INC. ("LICEN SOR") AND ARE NOT BEING SOLD. THIS AGREEMENT CONTAINS 

LIMITATIONS ON REPRESEN TATION S, WARRANTIES, CONDITION S, REMEDIES, AND LIABILITIES THAT ARE 

APPLICABLE TO THE SOFTWARE AND DOCUMENTATION. 

Epiphan Systems Inc.  
 

Software License 
 

IMPORTANT: BEFORE DOWNLOADING, IN STALLIN G, OR USIN G THE SOFTWARE AND DOCUMENTATION, 

PLEASE CAREFULLY READ THIS AGREEMENT WHICH CONTAINS THE TERMS AND CONDITIONS UNDER WHICH 

YOU ARE ACQUIRING A LICEN SE TO USE THE SOFTWARE AND DOCUMENTATION. IF YOU DO NOT ACCEPT THE 

TERMS AND CONDITIONS OF THIS AGREEMENT PLEASE DO NOT DOWNLOAD, IN STALL, OR USE THE SOFTWARE 

AND DOCUMENTATION AND PROMPTLY RETURN OR DESTROY THE SOFTWARE AND DOCUMENTATION. IF YOU 

DOWNLOAD, IN STALL, OR USE THE SOFTWARE AND/ OR DOCUMENTATION, YOU WILL HAVE ACCEPTED AND 

AGREED TO THESE TERMS AND CONDITION S. THE SOFTWARE, HARDWARE AND DOCUMENTATION ARE ALSO 

PROTECTED BY COPYRIGHT LAWS AND INTERNATIONAL COPYRIGHT TREATIES, AS WELL AS OTHER 

INTELLECTUAL PROPERTY LAWS. IF YOU ARE AN AGENT OR EMPLOYEE OF AN ENTITY, YOU REPRESEN T AND 

WARRANT THAT (I) THE INDIVIDUAL ACCEPTING THIS AGREEMENT IS DULY AUTHORIZED TO ACCEPT THIS 

AGREEMENT ON SUCH ENTITY'S BEHALF AND TO BIND SUCH ENTITY, AND (II) SUCH ENTITY HAS FULL POWER, 

CORPORATE OR OTHERWISE, TO ENTER INTO THIS AGREEMENT AND PERFORM ITS OBLIGATIONS UNDER THIS 

AGREEMENT. 

1. Definitions: In this Agreement: 
 

"Agreement" means this Epiphan System s Inc. Software License; 
 

"API" means an application programming interface; 
 

"Documentation" means the technical publications delivered to You with the Software relating to the installation 

and operation of the Software and/ or Hardware, such as reference, user, installation and technical guides and release 

notes; 

"Epiphan" means Epiphan System s Inc; 
 

"Epiphan Hardware Product" means an Epiphan hardware product (including enclosure and mechanical parts, 

circuitry and electrical and electronic components contained therein) purchased by You, which is intended to be used in 

conjunction with the licensed Software and Documentation; 

"License Key" means a series of computer-generated characters used for the purpose of controlling the operation of 

Epiphan Hardware Products and/ or related Software; 

"Soft ware" means the Licensor binary and/ or bytecode software and/ or firmware programs that are (i) specified in 

Your Order or that are included with or in the Epiphan Hardware Products specified in Your Order, (ii) are made available 

to You for download after acceptance of this Agreement, (iii) are packaged with this Agreement, (iv) pre- installed on 

Epiphan Hardware Products, (v) embed this Agreement in their installer(s) and which are installed after acceptance of 

this Agreement, or (vi) embed this Agreement in their product documentation. Software also includes the related 

Documentation; 
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"You" or "Your" means the individual acquiring the Software license or any entity on whose behalf such individual is 

acting. In the case of an entity, "You" includes any entity that by majority voting interest controls, is controlled by, or is 

under common control with You; and 

"Your Order" means (i) the web forms provided by Epiphan or its applicable reseller or distributor for ordering Epiphan 

Hardware Products and related Software licenses, or (ii) written documents executed by Epiphan, or one of its resellers 

or distributors, and You in respect to Your purchases of Epiphan Hardware Products and/ or related 

Software licenses. 
 

2. Grant of Soft ware License: Subject to the terms and conditions of this Agreement, including payment of any 

applicable fees specified in Your Order, Licensor grants You a non-exclusive, non-transferable, non-sublicensable, 

internal license to use the number of copies of the Software specified in Your Order and to use the Software functions 

specified in Your Order solely for operation on the Epiphan Hardware Products for which such Software has been 

designed as specified in the Documentation for such Software. If the number of copies of Software is not specified in 

Your Order, then the number of copies shall be a reasonable number of copies. You acknowledge and agree that the 

ability to use certain Software functions is controlled by a Licensing Key and that You will not be able to use such 

functions unless You have paid the applicable fees charged by Epiphan for the right to use such functions and to 

receive a Licensing Key to enable such functions. For functions that are controlled by a Licensing String You shall only use 

that Licensing String with the copy of the Software for which it was issued and You shall not use that copy of the Licensing 

String with any other copies of the Software that You may have or make. All copies of the Software made by You shall 

include all trademarks, copyright notices, restricted rights legends, proprietary markings and the like exactly as they appear 

on the copy of the Software originally provided to You. No other rights in the Software or 

Documentation are granted to You. 
 

3. Open Source Soft ware: Binary, bytecode and source code versions of certain open source software packages may 

be embedded in or distributed with the Software ("Open Source Software"). If a separate license agreement for an 

item of open source software is: delivered to You with the Software; included in the download package for the 

Software; referenced in any material (including the Documentation) that is included in the download or distribution package 

for the Software; or listed at www.epiphan.com/ opensource, then such open source software shall be Open Source 

Software and such separate license agreement shall govern Your use of that item or version of such open source software. 

The Open Source Software may include free software (i.e. software licensed under the GNU Lesser General Public 

License or other free software licenses) for which the applicable free software license may also require 

that the source code for such free software be made available to those receiving only executable versions of such free 

software. If the source code for any free software distributed with the Software is not provided with the Software, 

then upon request, within a three (3) year period from the original receipt of the binary or bytecode version of such Open 

Source Software from Licensor, for a fee that shall not exceed Licensor's costs associated with the shipping of 

the source code for such free software, Licensor will provide a copy of the source code for such free software to You. 
 

4. Restrictions: The terms set forth in this Section 4 are additional conditions to the licenses granted in Section 2. 

Your right to use the Software is conditioned upon Your timely payment of the full amount of fees due for: (i) the 

Epiphan Hardware Product(s) on which You want to use the Software; (ii) all support agreements You have entered 

into with Licensor or any of its distributors and/ or resellers; (iii) licensed Software and Documentation. 

You shall not reverse engineer, disassemble, reverse translate, decompile or in any other manner decode any 

Epiphan Hardware Product or Software except to the extent the Software is distributed with any Open Source 

Software that prohibits the imposition of such a restriction or to the extent the foregoing restriction is expressly 

prohibited by applicable law notwithstanding a contractual obligation to the contrary. You acknowledge and agree 

that no rights in respect to the source code of the Software are granted to You. You acknowledge and agree that the 

http://www.epiphan.com/opensource
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rights in respect to use of the Software and Documentation are granted only for use in conjunction with Epiphan Hardware 

Products. You shall not distribute, lease, rent, grant a security interest in, assign, or otherwise transfer the 

Software except as expressly provided in this Agreement. You shall not modify or create any derivatives works of the 

Software or merge all or any part of the Software with another program. Notwithstanding the foregoing, You may call public 

APIs made available by Epiphan in the Software from applications developed by or on Your behalf provided 

that such applications do not embed any of the Software other than the minimum linkage materials required to call 

separately running instances of the Software. You shall not use the Software or make the Software available to any third 

parties as part of any service bureau, time sharing service, application service provider offering, software-as-a- service 

offering or any other managed service offering. You shall not disclose any performance, benchmarking, or feature-related 

information about the Software. You further agree not to disclose, transfer or otherwise provide to any third party any 

portion of the Software, except as expressly permitted herein. 

Som e Epiphan Hardware Products and Software embed third-party APIs that integrate with third-party party services 

(“Third-Party Services”) to allow users of such Epiphan Hardware Products and Software to interact with such Third- Party 

Services for various capabilities offered by such Third-Party Services, such as, and without limitation, 

authentication, uploading and downloading of video content and other features made available by such Third-Party 

Services. If You access or use any Third-Party Service and/ or related APIs using an Epiphan Hardware Product and/ or 

the Software then You shall comply with all of the terms and conditions for such Third-Party Service and/ or related APIs. 

5. Disclaimer of Warranties: EXCEPT FOR ANY WARRANTIES THAT MAY BE PROVIDED IN ANY COMMERCIAL 

AGREEMENT EXECUTED BETWEEN YOU AND LICEN SOR (OR BETWEEN YOU AND ONE OF LICEN SOR’S RESELLERS 

OR DISTRIBUTORS), THE EPIPHAN HARDWARE PRODUCTS, SOFTWARE AND/ OR DOCUMENTATION ARE 

PROVIDED “AS IS”, WITHOUT ANY REPRESEN TATION S, CONDITION S, AND/ OR WARRANTIES OF ANY KIND. 

WITHOUT LIMITATION, LICEN SOR AND ITS AFFILIATES AND ITS AND THEIR LICEN SORS, SUPPLIERS, 

SUBCON TRACTORS, RESELLERS AND DISTRIBUTORS DISCLAIM ANY AND ALL IMPLIED REPRESEN TATION S, 

CONDITIONS AND/ OR WARRANTIES OF MERCHANTABILITY, MERCHANTABLE QUALITY, NON-INFRINGEMENT, 

DURABILITY, COMPATIBILITY, TITLE, SATISFACTORY QUALITY AND/ OR FITNESS FOR A PARTICULAR PURPOSE 

WHETHER ARISIN G BY STATUTE, COURSE OF DEALING, USAGE OF TRADE OR OTHERWISE. EXCEPT AS 

OTHERWISE EXPRESSLY PROVIDED IN ANY COMMERCIAL AGREEMENT EXECUTED BETWEEN YOU AND 

LICEN SOR (OR BETWEEN YOU AND ONE OF LICEN SOR’S RESELLERS OR DISTRIBUTORS), THE ENTIRE RISK OF 

THE USE OF THE EPIPHAN HARDWARE PRODUCTS, SOFTWARE AND/ OR DOCUMENTATION SHALL BE BORNE BY 

YOU. EXCEPT AS OTHERWISE EXPRESSLY PROVIDED IN ANY COMMERCIAL AGREEMENT EXECUTED BETWEEN 

YOU AND LICEN SOR (OR BETWEEN YOU AND ONE OF LICEN SOR’S RESELLERS OR DISTRIBUTORS), NEITHER 

LICEN SOR NOR ANY OF ITS AFFILIATES NOR ANY OF ITS OR THEIR LICEN SORS, SUPPLIERS, SUBCON TRACTORS, 

RESELLERS AND/ OR DISTRIBUTORS MAKE ANY REPRESEN TATIONS OR PROVIDE ANY CONDITIONS AND/ OR 

WARRANTIES ABOUT THE SUITABILITY OF THE EPIPHAN HARDWARE PRODUCTS, SOFTWARE, SERVICES AND/ OR 

DOCUMENTATION. NEITHER LICEN SOR NOR ANY OF ITS AFFILIATES NOR ANY ITS OR THEIR LICEN SORS, 

SUPPLIERS, SUBCON TRACTORS, RESELLERS AND/ OR DISTRIBUTORS MAKE ANY REPRESEN TATIONS OR PROVIDE 

ANY CONDITIONS AND/ OR WARRANTIES WHATSOEVER ABOUT ANY INFORMATION AND/ OR DATA THAT MAY 

BE PROCESSED BY OR MADE AVAILABLE USIN G ANY EPIPHAN HARDWARE PRODUCT AND/ OR SOFTWARE OR 

ABOUT ANY THIRD-PARTY SERVICE THAT MAY BE ACCESSIBLE USIN G ANY EPIPHAN HARDWARE PRODUCT 

AND/ OR SOFTWARE. 
 

6. LIMITATION OF LIABILITY: NEITHER LICEN SOR NOR ANY OF ITS AFFILIATES NOR ANY OF ITS OR THEIR 

LICEN SORS, SUPPLIERS, SUBCON TRACTORS, RESELLERS AND/ OR DISTRIBUTORS SHALL HAVE ANY LIABILITY TO 

YOU OR ANY OTHER PERSON OR ENTITY FOR ANY DAMAGES ARISIN G FROM THIS AGREEMENT, RELATING TO 
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THE HARDWARE, SOFTWARE OR DOCUMENTATION, OR RELATING TO ANY SERVICES PROVIDED TO YOU BY 

LICEN SOR (INCLUDING ITS AFFILIATES AND ITS AND THEIR LICEN SORS, SUPPLIERS, SUBCON TRACTORS, 

RESELLERS AND/ OR DISTRIBUTORS) IN RELATION TO THE EPIPHAN HARDWARE PRODUCTS, SERVICES, 

SOFTWARE AND/ OR DOCUMENTATION FOR ANY INDIRECT, RELIANCE, INCIDENTAL, SPECIAL, PUNITIVE, 

EXEMPLARY OR CON SEQUEN TIAL DAMAGES, INCLUDING, BUT NOT LIMITED TO, LOSS OF REVENUE OR PROFIT, 

LOSS OF OR DAMAGE TO DATA, BUSIN ESS INTERRUPTION, LOSS OF DATA, REPLACEMENT OR RECOVERY 

COSTS, OR OTHER COMMERCIAL OR ECONOMIC LOSS, WHETHER ARISIN G FROM CONTRACT, EQUITY, TORT 

(INCLUDING NEGLIGENCE OR STRICT LIABILITY) OR ANY OTHER THEORY OF LIABILITY, EVEN IF LICEN SOR 

(INCLUDING ITS AFFILIATES AND ITS AND THEIR LICEN SORS, SUPPLIERS, SUBCON TRACTORS, RESELLERS 

AND/ OR DISTRIBUTORS) HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR THEY ARE 

FORESEEABLE. THE LIMITATIONS IN THIS SECTION SHALL APPLY WHETHER OR NOT THE ALLEGED BREACH OR 

DEFAULT IS A BREACH OF A FUNDAMENTAL CONDITION OR TERM OR FUNDAMENTAL BREACH. SOM E 

JURISDICTION S DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CON SEQUEN TIAL OR 

INCIDENTAL DAMAGES, SO THESE LIMITATIONS MAY NOT APPLY TO YOU. IN NO EVENT SHALL THE TOTAL 

CUMULATIVE LIABILITY OF LICEN SOR (INCLUDING ITS AFFILIATES AND ITS AND THEIR LICEN SORS, SUPPLIERS, 

SUBCON TRACTORS, RESELLERS AND DISTRIBUTORS) TO YOU OR ANY OTHER PERSON OR ENTITY FOR ANY 

DAMAGES ARISIN G FROM THIS AGREEMENT, RELATING TO THE EPIPHAN HARDWARE PRODUCTS, SOFTWARE, 

DOCUMENTATION AND/ OR RELATING TO ANY SERVICES PROVIDED TO YOU BY LICEN SOR (INCLUDING ITS 

AFFILIATES AND ITS AND THEIR LICEN SORS, SUPPLIERS, SUBCON TRACTORS, RESELLERS AND DISTRIBUTORS) IN 

RELATION TO THE EPIPHAN  HARDWARE PRODUCTS,  SOFTWARE AND/ OR DOCUMENTATION, EXCEED  THE 

LICEN SE FEES PAID BY YOU FOR THE SOFTWARE. 

NOTWITHSTAN DING ANY OTHER PROVISION IN THIS AGREEMENT, NEITHER LICEN SOR NOR ANY OF ITS 

AFFILIATES OR ITS OR THEIR LICEN SORS, SUPPLIERS, SUBCON TRACTORS, RESELLERS AND/ OR DISTRIBUTORS 

SHALL HAVE ANY LIABILITY TO YOU OR ANY OTHER PERSON OR ENTITY WHATSOEVER IN RESPECT TO ANY 

DIRECT, INDIRECT, RELIANCE, INCIDENTAL, SPECIAL, PUNITIVE, EXEMPLARY OR CON SEQUEN TIAL DAMAGES, 

INCLUDING, BUT NOT LIMITED TO, LOSS OF REVENUE OR PROFIT, LOSS OF OR DAMAGE TO DATA, BUSIN ESS 

INTERRUPTION, LOSS OF DATA, REPLACEMENT OR RECOVERY COSTS, OR OTHER COMMERCIAL OR ECONOMIC 

LOSS, ARISIN G FROM OR RELATING TO ANY INFORMATION AND/ OR DATA THAT MAY BE PROCESSED BY OR 

MADE AVAILABLE USIN G ANY EPIPHAN HARDWARE PRODUCT AND/ OR SOFTWARE OR ARISIN G FROM OR 

RELATING TO ANY THIRD-PARTY SERVICE THAT MAY BE ACCESSIBLE USIN G ANY EPIPHAN HARDWARE 

PRODUCT AND/ OR SOFTWARE. 

THE DISCLAIM ER OF REPRESEN TATION S, WARRANTIES AND CONDITIONS AND LIMITATION OF LIABILITY 

CON STITUTE AN ESSEN TIAL PART OF THIS AGREEMENT. YOU ACKNOWLEDGE THAT BUT FOR THE DISCLAIM ER 

OF REPRESEN TATION S, WARRANTIES AND CONDITIONS AND LIMITATION OF LIABILITY, NEITHER LICEN SOR 

NOR ANY OF ITS AFFILIATES OR ITS OR THEIR LICEN SORS, SUPPLIERS, RESELLERS OR DISTRIBUTORS WOULD 

GRANT THE RIGHTS GRANTED IN THIS AGREEMENT. 

7. Term and Termination: This Agreement shall continue for as long as You use the Software, however, it may be 

terminated sooner as provided in this Section 7. You may terminate this Agreement by destroying all copies of the 

Software and Documentation under Your control and providing certification of such destruction to Licensor or by 

returning the Software to Licensor. Licensor may terminate this Agreement immediately by providing You with written notice 

if: (a) You are in material breach of any provision of this Agreement, which breach, if capable of being cured, is not cured 

within thirty (30) days after Licensor gives You written notice thereof; or (b) You have committed a non- 

curable material breach of this Agreement. Upon termination You shall destroy all copies of the Software and 

Documentation. In addition to this Section, the Sections entitled Definitions, Disclaimer of Warranties, Limitation of 
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Liability, Title, Indemnities, High-Risk Activities, Intellectual Property, and General shall continue in force even after any 

termination of this Agreement. No termination of this Agreement will entitle You to a refund of any amounts paid by You to 

Licensor or any reseller or distributor or affect any obligations You may have to pay any outstanding 

amounts owing to Licensor or any reseller or distributor. Upon any termination of this Agreement, Your license to the 

Software and Documentation will terminate and You shall destroy all copies of the Software and Documentation under 

Your control and certify such destruction to Licensor. 

8. Support and Updates: This Agreement does not grant You the right to any updates or enhancements of the 

Software or the right to receive any technical support for the Software. Such updates and other technical support 

services, if available, may be purchased separately from Licensor or one of Licensor’s resellers or distributors. Use of any 

updates or enhancements to the Software provided pursuant to any technical support You may procure from Licensor or 

one of Licensor’s resellers or distributors shall be governed by the terms and conditions of this 

Agreement. Licensor reserves the right at any time not to release or to discontinue the release of any Software and to alter 

prices, features, specifications, capabilities, functions, licensing terms, release dates, general availability or other 

characteristics of the Software. 

9. Title: All right, title, and interest (including all intellectual property rights) in, to, and under the Software (including 

all copies thereof) shall remain with Licensor and its licensors. 

10. Indemnities: You shall indemnify, defend and hold Licensor, its affiliates, its and their licensors, suppliers, 

subcontractors, resellers and/ or distributors and all of the directors, officers, employees of all of the foregoing 

(collectively the “Indemnified Parties”) harmless from and against any damages, losses, liabilities, expenses, costs, 

claims, demands, actions, suits and/ or proceedings incurred by the Indemnified Parties as a result of (i) Your use of 

the Epiphan Hardware Products, Software and/ or Documentation, (ii) any use of the Epiphan Hardware Products, 

Software and/ or Documentation on Your behalf, (iii) the use of the Epiphan Hardware Products, Software and/ or 

Documentation by anyone to whom You give the Epiphan Hardware Products, Software and/ or Documentation, 

and/ or (iv) the use of the Epiphan Hardware Products, Software and/ or Documentation on behalf of anyone to whom 

You give the Epiphan Hardware Products, Software and/ or Documentation, including, without limitation, in all of the 

foregoing cases, any damages, losses, liabilities, expenses, costs, claims, demands, actions, suits and/ or proceedings 

arising from or relating to any information and/ or data that may be processed by or made available using any 

Epiphan Hardware Product and/ or Software or arising from or relating to any Third-Party Service that may be 

accessible using any Epiphan Hardware Product and/ or Software (collectively, each matter falling within any of the 

foregoing, a “Claim”), including, without limitation, indemnifying, defending and holding the Indemnified Parties 

harmless from and against any settlements agreed by You in connection with any Claims and/ or any damages, costs 

or other amounts (including reasonable attorneys' fees) awarded to a third party against any of the Indemnified 

Parties by a court or tribunal of competent jurisdiction in respect to any Claim. If You do not timely defend against or 

resist a Claim after notice from Licensor, Licensor shall be entitled to investigate, defend, compromise, settle, or 

otherwise dispose of the Claim, and incur costs in connection therewith, at Your expense, in such manner as Licensor 

deems in its best interests until a reasonable time after You comply with its obligations under this Section 10. You shall not 

enter into a settlement of any Claim without the Licensor’s written consent unless such settlement is solely for monetary 

payment by You and contains an express, complete, unconditional release of all of the Indemnified 

Parties and which does not impose any obligations or restrictions on any of the Indemnified Parties. 
 

11. High-Risk Activities: The Software and Epiphan Hardware Products are not fault-tolerant and are not designed, 

manufactured or intended for use in or in conjunction with on-line control equipment in hazardous environments 

requiring fail-safe performance, such as in the operation of nuclear facilities, aircraft navigation systems, air traffic 
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control, or direct life support machines. Licensor, its licensors, suppliers, subcontractors, resellers and distributors 

specifically disclaim any express or implied representations, warranties and/ or conditions for such uses. 

12. U.S. Government End-Users: The Software and Documentation are each a "commercial item" as that term is 

defined at FAR 2.101, consisting of "commercial computer software" and "commercial computer software 

documentation" as such terms are defined in FAR 12.212, and are provided to the U.S. Government only as 

commercial end items. Government end users acquire the rights set out in this Agreement for the Software, Epiphan 

Hardware Products and Documentation consistent with: (i) for acquisition by or on behalf of civilian agencies, the 

terms set forth in FAR12.212; or (ii) for acquisition by or on behalf of units of the Department of Defense, the terms set 

forth in DFARS 227.7202. Use of the Epiphan Hardware Products, Software and Documentation is further 

restricted by the terms and conditions of this Agreement and the applicable commercial purchase agreement for the 

Epiphan Hardware Products. For the purposes of any applicable government use, the Epiphan Hardware Products, 

Software and Documentation were developed exclusively at private expense, and are trade secrets of Epiphan 

System s Inc. for the purpose of any Freedom of Information legislation or any other disclosure statute, regulation or 

provision. 

13. Export Restrictions: The Epiphan Hardware Products, Software, Documentation and related information are 

subject to export and import restrictions. By downloading, installing, or using the Software, Epiphan Hardware 

Products, Documentation and/ or related information, You are representing and warranting that You are not located in, are 

not under the control of, and are not a national or resident of any country to which the export of the Epiphan Hardware 

Products, Software, Documentation and/ or related information would be prohibited by the laws and/ or 

regulations of Canada or the United States. You are also representing and warranting that You are not an individual to 

whom the export of the Epiphan Hardware Products, Software, Documentation or related information would be 

prohibited by the laws and/ or regulations of Canada or the United States. You shall comply with the export laws and 

regulations of Canada and the United States that are applicable to the Epiphan Hardware Products, Software, 

Documentation and related information and You shall also comply with any local laws and/ or regulations in Your 

jurisdiction that may impact Your right to export, import, or use the Epiphan Hardware Products, Software, 

Documentation or related information, and You represent and warrant that You have complied with any such 

applicable laws and/ or regulations. The Epiphan Hardware Products, Software, Documentation and related 

information shall not be used for any purposes prohibited by export laws and/ or regulations, including, without 

limitation, nuclear, chemical, or biological weapons proliferation. You shall be responsible for procuring all required 

permissions for any subsequent export, import, or use of the Epiphan Hardware Products, Software, Documentation or 

related information. 

14. Intellectual Property: Epiphan, Epiphan System s and Epiphan Video are tradenames, trademarks or registered 

trademarks of Epiphan System s Inc. in certain countries. All Licensor product names and logos are trademarks or 

registered trademarks of Epiphan System s Inc. in certain countries. All other company and product names and logos are 

trademarks or registered trademarks of their respective owners in certain countries. You shall not disclose, 

transfer or otherwise provide to any third party any portion of the Software, except as expressly permitted in this 

Agreement. 

15. General: This Agreement is the entire agreement between You and Licensor in respect to the Software, 

superseding any other agreements or discussions, oral or written. The terms and conditions of this Agreement shall 

prevail over any pre-printed terms on any quotes, orders, purchase orders, or purchase order acknowledgements, and 

shall prevail over any other communications between the parties in relation to the Software. You may not assign this 

Agreement whether voluntarily, by operation of law, or otherwise without Licensor's prior written consent. 

Licensor may assign this Agreement at any time without notice. The failure of a party to claim a breach of any term of 
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this Agreement shall not constitute a waiver of such breach or the right of such party to enforce any subsequent 

breach of such term. If any provision of this Agreement is held to be unenforceable or illegal, such decision shall not 

affect the validity or enforceability of such provisions under other circumstances or the remaining provisions of this 

Agreement and such remaining provisions shall be reformed only to the extent necessary to make them enforceable 

under such circumstances. This Agreement shall be governed by the laws of the Province of Ontario and the laws of 

Canada applicable therein. No choice or conflict of laws rules of any jurisdiction shall apply to this Agreement. You 

shall only be entitled to bring any action or proceeding arising out of or relating to this Agreement, the Epiphan 

Hardware Products, Software, Documentation or any services provided in respect to the Epiphan Hardware Products, 

Software and/ or Documentation in a court in Ottawa, Ontario, Canada, and You consent to the jurisdiction of such 

courts for any such action or proceeding. You waive all rights that You may have or that may hereafter arise to contest 

the jurisdiction of such courts for any action or proceeding brought by You. You hereby waive any right You may have 

to request a jury trial with respect to any action brought by You in connection with this Agreement, the Epiphan 

Hardware Products or Software or any services provided in respect to the Epiphan Hardware Products or Software. The 

application of the United Nations Convention on Contracts for the International Sale of Goods to this Agreement is 

expressly excluded. 

 

 
Environmental Information 

 

The equipment that you bought has required the extraction and use of natural resources for its production. It may contain 

hazardous substances that could impact health and the environment. In order to avoid the dissemination of those 

substances in our environment and to diminish the pressure on the natural resources, we encourage you to use the 

appropriate take-back systems. Those systems will reuse or recycle most of the materials of your end life equipment in a 

sound way. The crossed-out wheeled bin symbol invites you to use those systems. If you need more 

information about collection, reuse and recycling systems, please contact your local or regional waste administration. You 

can also contact us for more information on the environmental performance of our products. 

Important Safet y Warnings 
 

WARNING: This product has no user-serviceable parts and the battery used in this device is not replaceable. Do not 

attempt to disassemble. Return the device for service. 

CAUTION, RISK OF ELECTRIC SHOCK: This device may have multiple AC power cords installed. All power sources shall 

be disconnected before servicing to avoid shock hazard. 

ATTENTION: Cet appareil ne contient aucun composant pouvant être entretenu ou réparé par l'utilisateur. En cas de 

panne, retourner l'appareil pour réparation. 

ATTENTION, RISQUE DE CHOC ÉLECTRIQUE: Cet appareil peut être équipé de multiples cordons d'alimentation en 

courant alternatif. Pour placer cet appareil hors tension, débrancher tous les cordons d'alimentation sans exception. 

FCC Compliance St atement 
 

47 CFR Section 2.1077 Compliance Information 

Unique identifier: DVI2USB 3.0 

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: 
 

1. This device may not cause harmful interference 
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2. This device must accept any interference received, including interference that may cause undesired operation. 

Responsible party (US contact): 

Epiphan Video 

459 Hamilton Avenue, Suite 301 

Palo Alto, CA 

94301, USA 
 

www.Epiphan.com 
 

FCC CAUTION 
 

Changes or modifications not expressly approved by the party responsible for compliance could void the user’s 

authority to operate the equipment. 

Note: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to 

part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a 

residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and 

used in accordance with the instructions, may cause harmful interference to radio communications. However, 

there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful 

interference to radio or television reception, which can be determined by turning the equipment off and on, the user is 

encouraged to try to correct the interference by one or more of the following measures: 

– Reorient or relocate the receiving antenna. 
 

– Increase the separation between the equipment and receiver. 
 

– Connect the equipment into an outlet on a circuit different from that to which the receiver is connected. 
 

– Consult the dealer or an experienced radio/ TV technician for help. 
 

Innovation, Science and Economic Development Canada: 
 

This device complies with ICES-003 of the ISED rules. Operation is subject to the following two conditions: 
 

(1) This device may not cause harmful interference, and 
 

(2) this device must accept any interference received, including interference that may cause undesired operation. 
 

Cet appareil est conforme à la norme ISED NBM-003 pour les appareils radio agréés. Son fonctionnement est sujet aux 

deux conditions suivantes: 

(1) le dispositif ne doit pas produire de brouillage préjudiciable, et 
 

(2) ce dispositif doit accepter tout brouillage reçu, y compris un brouillage susceptible de provoquer un 

fonctionnement indésirable. 

CE Compliance St atement 

Marking by the symbol  indicates compliance of this device with the applicable directives of the European 

Community and meets or exceeds the following technical standards: 

Directive 2014/ 30/ EU - Electrom agnetic Compatibility 

http://www.epiphan.com/
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Directive 2011/ 65/ EU - RoHS, restriction of the use of certain hazardous substances in electrical and electronic 

equipment 

 
 
 

 

Other Jurisdict ional Issues 
 

Epiphan makes no representation that its products or information in this document or its web site is appropriate or available 

for use in your jurisdiction. Those who choose to access the Epiphan web site or use Epiphan products do so on their own 

initiative and are responsible for compliance with local laws, if and to the extent local laws are applicable 

Subm issions to Epiphan and Affiliated Servers 
 

Any information, including but not limited to remarks, suggestions, ideas, graphics, or other submissions, 

communicated to Epiphan through their Epiphan web site is the exclusive property of Epiphan. Epiphan is entitled to use 

any information submitted for any purpose, without restriction (except as stated in Epiphan's Privacy Statem ent) or 

compensation to the person sending the submission. The user acknowledges the originality of any submission 

communicated to Epiphan and accepts responsibility for its accuracy, appropriateness, and legality. 

Third Parties and Links to Third-Party Web Sites 
 

Mention of non-Epiphan System s Inc. products or services on their website, or this document site is for informational 

purposes and does not constitute an endorsement or recommendation. 

This document may contain links to non-Epiphan web sites. These links are provided to you as a convenience, and 

Epiphan is not responsible for the content of any linked web site. Any outside web site accessed from the Epiphan web 

site is independent from Epiphan, and Epiphan has no control over the content of that web site. In addition, a link to any 

non-Epiphan web site does not imply that Epiphan endorses or accepts any responsibility for the content or use of such a 

web site. 

In no event shall any reference to any third party or third party product or service be construed as an approval or 

endorsement by Epiphan of that third party or of any product or service provided by a third party. 

Miscellaneous 
 

It is the user's responsibility to ascertain whether any information downloaded from the Epiphan web site or other 

websites is free of viruses, worms, trojan horses, or other items of a potentially destructive nature. 

Enforcement of Terms and Conditions 
 

These Terms and Conditions for use of this document and the associated Epiphan Product are governed and 

interpreted pursuant to the laws of the province of Ontario, Canada, notwithstanding any principles of conflicts of law. 

All disputes arising out of or relating to these Terms and Conditions shall be finally resolved by arbitration conducted in the 

English language in Ottawa, Ontario, Canada under the commercial arbitration rules of the Canada. The parties shall 

appoint as sole arbitrator a retired judge who presided in the province of Ontario. The parties shall bear equally 
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the cost of the arbitration (except that the prevailing party shall be entitled to an award of reasonable attorneys' fees 

incurred in connection with the arbitration in such an amount as may be determined by the arbitrator). All decisions of the 

arbitrator shall be final and binding on both parties and enforceable in any court of competent jurisdiction. 

Notwithstanding this, application may be made to any court for a judicial acceptance of the award or order of 

enforcement. Notwithstanding the foregoing, Epiphan shall be entitled to seek injunctive relief, security, or other 

equitable remedies from any court of competent jurisdiction. 

If any part of these terms is unlawful, void, or unenforceable, that part will be deemed severable and will not affect the 

validity and enforceability of the remaining provisions. Epiphan may, at its sole discretion and without notice, 

revise these terms at any time by updating this posting. 
 

Copyright © 2018 Epiphan System s Inc. 
 

All Rights Reserved. 
 

© and ™2018, Epiphan Systems, Inc 


